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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Product Name

Compaq 320 Notebook PC

√

√
√

Compaq 321 Notebook PC
Compaq 420 Notebook PC

√

√
√

Compaq 421 Notebook PC
Compaq 620 Notebook PC

√

√
√

Compaq 621 Notebook PC

Processors

Discrete
graphics,
PM45
chipset

HP 420 Notebook PC

√

√

HP 620 Notebook PC

√

√

Intel® Celeron® processors
T3300, 2.00-GHz, 800-MHz FSB, 1-MB
cache

√

T3100, 1.90-GHz, 800-MHz FSB, 1-MB
cache

√

T3000, 1.80-GHz, 800-MHz FSB, 1-MB
cache

√

T1700, 1.83-GHz, 667-MHz FSB, 1-MB
cache

√

T1600, 1.66-GHz, 667-MHz FSB, 1-MB
cache

√

900, 2.20-GHz, 800-MHz FSB, 1-MB cache

√

√

T4400, 2.20-GHz, 800-MHz FSB, TJ 100

√

√

T4300, 2.10-GHz, 800-MHz FSB, TJ 100

√

√

T4200, 2.00-GHz, 800-MHz FSB, TJ 100

√

√

Intel® Pentium® processor

Intel® Core™ 2 Duo processor
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Category

Chipsets

Description

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

T5870, 2.00-GHz, 800-MHz FSB, 2-MB
cache

√

√

P7570, 2.26-GHz, 1066-MHz FSB, 3-MB
cache

√

√

P7370, 2.00-GHz, 1066-MHz FSB, 3-MB
cache

√

√

T6670, 2.20-GHz, 800-MHz FSB, 2-MB
cache

√

√

T6570, 2.10-GHz, 800-MHz FSB, 2-MB
cache

√

√

Intel GL40 with 667-MH FSB

UMA
graphics,
GL40 chipset

√
√

Intel GM45 with up to 1066-MHz FSB

√

Intel PM45 with up to 1066-MHz FSB

Graphics

ICH-9M Southbridge

√

Intel GMA 4500M Universal Memory
Architecture (UMA) graphics subsystem
integrated with shared video memory
(dynamically allocated)

√
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√

√

Intel GMA 4500MHD Universal Memory
Architecture (UMA) graphics subsystem
integrated with shared video memory
(dynamically allocated)

Panels

√

ATI Mobility Radeon HD 530v with 512-MB
memory

√

ATI Mobility Radeon HD 5470v with 512-MB
memory

√

All display assemblies support privacy filter

√

√

√

33.8-cm (13.3-in) HD LED backlight panel:

√

√

√

●

1366×768 AntiGlare

●

1366×768 AntiGlare for webcam

●

1366×768 BrightView

●

1366×768 BrightView for Webcam

Chapter 1 Product description

Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

35.6-cm (14.0-in) HD LED backlight panel:

√

√

√

√

√

√

2 customer-accessible/upgradable memory
module slots

√

√

√

Supports dual-channel memory

√

√

√

Supports up to 4 GB of system RAM

√

√

√

PC3-10600, 1333-MHz, DDR3

√

√

√

Supports the following configurations in all
countries and regions:

√

√

√

Supports 7.0 and 9.5-mm, 6.35-cm (2.50-in)
hard drives

√

√

√

Customer-accessible

√

√

√

Serial ATA

√

√

√

●

1366×768 AntiGlare

●

1366×768 AntiGlare for webcam

●

1366×768 BrightView

●

1366×768 BrightView for Webcam

39.6-cm (15.6-in) HD LED backlight panel:

Memory

Hard drives

●

1366×768 AntiGlare

●

1366×768 AntiGlare for webcam

●

1366×768 BrightView

●

1366×768 BrightView for Webcam

●

4096-MB total system memory (4096MB × 1)

●

4096-MB total system memory (2048MB× 2, dual-channel)

●

3072-MB total system memory (2048MB + 1024-MB, dual-channel)

●

2048-MB total system memory (2048MB × 1)

●

2048-MB total system memory (1024MB × 2, dual-channel)

●

1024-MB total system memory (1024MB × 1)
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Category

Optical drives

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

Supports the following drives:

√

√

√

HP DriveGuard (not available on Linux)

√

√

√

Fixed, no modular requirements

√

√

√

SATA 12.7-mm tray load

√

√

√

Supports option of no optical drive

√

√

√

Supports the following drives:

√

√

√

●

500-GB, 7200-rpm

●

500-GB, 5400-rpm

●

320-GB, 7200-rpm

●

320-GB, 5400-rpm

●

250-GB, 7200-rpm

●

250-GB, 5400-rpm

●

160-GB, 7200-rpm

●

160-GB, 5400-rpm

●

DVD-ROM Drive

●

DVD±RW SuperMulti Double-Layer
Combo Drive with Lightscribe

Diskette drive

Supports external USB diskette drive only

√

√

√

Audio/Visual

IDT 92HD88

√

√

√

Integrated microphone

√

√

√

Single speaker

√

√

√

Headphone and microphone jacks

√

√

√

Integrated 2MP camera with fixed focus
(select models only)

√

√

√

56K V.92 3.8 cm (1.5-in) data/fax modem

√

√

√

Supports no modem option

√

√

√

For use in all countries and regions except
APJ

√

√

√

For use in APJ only

√

√

√

Modem cable not included

√

√

√

10/100 Ethernet network interface card
(NIC)

√

√

√

Modem

Ethernet
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Description
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Category

Wireless

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

S3/S4/S5 wake on LAN: AC only mode

√

√

√

Ethernat cable not included

√

√

√

Integrated WLAN options by way of MiniPCI card:
2 WLAN antennas built into display assembly

√

√

√

Supports option for no-WLAN

√

√

√

Support for the following WLAN formats:

√

√

√

●

Broadcom 802.11b/g

●

Broadcom 802.11b/g/n (1 x 1)

●

Atheros 802.11 b/g/n (1 x 1)

●

Ralink 802.11b/g/n

●

Realtek 802.11 b/g/n (1 x 1)

●

Intel 802.11 b/g/n (1 x 2)

Integrated wireless personal area network (WPAN) options by way of Bluetooth®
module:

External media
cards

Ports

Support option for no-WPAN

√

√

√

Bluetooth 2.1

√

√

√

One ExpressCard/33-mm

√

√

√

Media Card Reader supporting Secure Digital
(SD) Memory Card, Secure Digital High
Capacity (SDHC) Memory Card,
MultiMediaCard (MMC) formats

√

√

√

Audio-in (microphone)

√

√

√

Audio-out (stereo headphone)

√

√

√

RJ-11 (modem)

√

√

√

RJ-45 (Ethernet, includes link and activity
lights)

√

√

√

USB 2.0 (3)

√

√

√

HP non-Smart adapter

√

√

√

VGA (Dsub 15-pin) supporting 1600 × 1200
external resolution at 75-GHz (hot plug/
unplug with auto-detect)

√

√

√

Multi-pin AC power

√

√

√

HDMI

√

√

√
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Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

Keyboard/
pointing devices

39.6-cm (15.6-in) keyboard with TouchPad

√

√

√

35.6-cm (14.0-in)/33.8-cm (13.3-in)
keyboard with TouchPad

√

√

√

Suports 2-way scroll with legend and gestures
(taps enabled as default)

√

√

√

65-W non-Smart AC adapter

√

√

Power
requirements

√

90-W non-Smart AC adapter
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6-cell, 47-Wh Li-ion battery

√

√

√

9-cell, 93-Wh Li-ion battery

√

√

√

Security

Supports Kensington security lock

√

√

√

Operating system

Preinstalled with Microsoft Office:

√

√

√

Windows 7 Home Premium 32 with Office
2010 Starter – EDGI

√

√

√

Windows 7 Home Premium 64 with Office
2010 Starter (excludes Japan )

√

√

√

Windows 7 Home Premium 64 with Office
2010 Starter – EDGI

√

√

√

Windows 7 Home Premium 32 with Office
2007 Personal (Japan only)

√

√

√

Windows 7 Home Premium 32 with Office
2007 Personal with PowerPoint (Japan only)

√

√

√

Windows 7 Home Premium 32 with Office
2007 Professional (Japan only)

√

√

√

Windows 7 Home Premium 32 with Office
2010 Home and Business (Japan only)

√

√

√

Windows 7 Home Premium 64 with Office
2010 Personal (Japan only)

√

√

√

Windows 7 Home Premium 64 with Office
2010 Home and Business (Japan only)

√

√

√

Windows 7 Home Premium 64 with Office
2007 Professional (Japan only)

√

√

√

Windows 7 Professional 32 with Office 2010
Starter (excludes Japan)

√

√

√

Windows 7 Professional 32 with Office 2010
Starter – MSNA

√

√

√
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Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

Windows 7 Professional 32 with Office 2010
Starter – EDGI

√

√

√

Windows 7 Professional 64 with Office 2010
Starter (excludes Japan)

√

√

√

Windows Vista Home Basic 32 with Office
2010 Starter (excludes Japan)

√

√

√

Windows 7 Professional 32 with Office 2007
Personal (Japan only)

√

√

√

Windows 7 Professional 32 with Office 2007
Personal with PowerPoint (Japan only)

√

√

√

Windows 7 Professional 32 with Office 2007
Professional (Japan only)

√

√

√

Windows 7 Professional 32 with Office 2010
Personal (Japan only)

√

√

√

Windows 7 Professional 32 with Office 2010
Home and Business (Japan only)

√

√

√

Windows 7 Professional 64 with Office 2010
Persoal (Japan only)

√

√

√

Windows 7 Professional 64 with Office 2010
Home and Business (Japan only)

√

√

√

Windows 7 Professional 64 with Office 2007
Professional (Japan only)

√

√

√

Windows Vista Home Basic 32 with Office
2007 Personal (Japan only)

√

√

√

Windows Vista Home Basic 32 with Office
2007 Professional and PowerPoint (Japan
only)

√

√

√

Windows Vista Home Basic 32 with Office
2010 Personal (Japan only)

√

√

√

Windows Vista Home Basic 32 with Office
2007 Professional (Japan only)

√

√

√

Windows Vista Home Basic 32 with Office
2010 Home and Business (Japan only)

√

√

√

Windows Vista Home Basic 32 with Office
2010 Professional (Japan only)

√

√

√

Windows 7 Starter with Office 2007 ready
(excludes Japan)

√

√

√

Windows 7 Starter 32 with Office 2010
Starter– EDGI

√

√

√
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Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

Windows 7 Home Basic 32 with Office 2007
ready (excludes Japan)

√

√

√

Windows 7 Home Basic 32 with Office 2010
Starter

√

√

√

Windows 7 Home Premium 32 with Office
2010 Starter (excludes Japan)

√

√

√

Windows 7 Professional 64 with Office 2010
Starter– EDGI

√

√

√

Windows 7 Professional 32 with XP Pro
images with Office 2007 ready (excludes
Japan)

√

√

√

Windows 7 Professional 32 with XP Pro
images with Office 2007 ready – EDGI

√

√

√

Windows 7 Professional 32 with XP Pro
images with Office 2007 Personal (Japan
only)

√

√

√

Windows 7 Professional 32 with XP Pro
images with Office 2007 Personal with
PowerPoint (Japan only)

√

√

√

Windows 7 Professional 32 with XP Pro
images with Office 2007 Professional (Japan
only)

√

√

√

Windows 7 Professional 32 with MS Basics
(Japan only)

√

√

√

Windows 7 Home Premium 32 with MS
Basics (Japan only)

√

√

√

Windows 7 Home Premium 64 with MS
Basics (Japan only)

√

√

√

Windows Vista Home Basic 32 with MS
Basics (Japan only)

√

√

√

Windows 7 Professional 32 (with XP
Professional images) with MS Basics (Japan
only)

√

√

√

Windows 7 Home Professional 64 with MS
Basics (Japan only)

√

√

√

FreeDOS

√

√

√

RedFlag Linux (People's Republic of China
only)

√

√

√

SuSE Linux

√

√

√

Preinstalled:
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Category

Description

UMA
graphics,
GL40 chipset

UMA
graphics,
GM45 chipset

Discrete
graphics,
PM45
chipset

Windows 7 Home Basic 32

√

√

√

Windows 7 Home Premium 32

√

√

√

Windows 7 Home Premium 64

√

√

√

Windows 7 Starter

√

√

√

Windows Vista Basic 32

√

√

√

Windows 7 Professional 32

√

√

√

Windows 7 Professional 64

√

√

√

DRDVD Windows 7 – Home Premium/Pro

√

√

√

DRDVD Windows 7 – Starter/Home Basic

√

√

√

Windows XP Professional

√

√

√

SRDVD SuSE Linux

√

√

√

Red Flag Linux (People's Republic of China
only)

√

√

√

DRDVD Windows Vista

√

√

√

DRDVD Windows XP Pro

√

√

√

Microsoft® WHQL

√

√

√

SuSE Linux

√

√

√

All Windows Vista 64 versions

√

√

√

Windows 7 Professional 64 versions

√

√

√

SuSE Linux

√

√

√

AC adapter

√

√

√

Battery (system)

√

√

√

Hard drive

√

√

√

Memory module

√

√

√

Keyboard

√

√

√

Optical drive

√

√

√

WLAN module

√

√

√

Restore media:

Certified:

Web Support:

Serviceability

End-user replaceable parts:
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External component identification

Top Components
TouchPad
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Component

Description

(1)

TouchPad *

Moves the pointer and selects or activates items on the screen.

(2)

TouchPad button

The left and right sides of the single button function like the left and
right buttons on an external mouse.

(3)

TouchPad scroll zone

Scrolls up or down.

Chapter 2 External component identification

Lights
NOTE: Refer to the illustration that most closely matches your computer.

Component

Description

(1)

On: Caps lock is on.

Caps lock light

Top Components
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Component

Description

(2)

●

On: The computer is on.

●

Blinking: The computer is in the Suspend state.

●

Off: The computer is off or in Hibernation.

●

White: An integrated wireless device, such as a wireless
local area network (WLAN) device is on.

●

Amber: All wireless devices are off.

(3)

12

Power light

Wireless light

Chapter 2 External component identification

Buttons, switch, and speaker

Component

Description

(1)

Speaker

Produces sound.

(2)

Internal display switch

Turns off the display if the panel lid is closed while the power is
on.

(3)

Power button

●

When the computer is off, press the button to turn on the
computer.

●

When the computer is on, press the button to shut down the
computer.

●

When the computer is in the Suspend state, press the button
briefly to exit Suspend.

●

When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

Top Components
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Keys
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Component

Description

(1)

esc key

Displays system information when pressed in combination with the
fn key.

(2)

fn key

Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc key.

(3)

Wireless key

Because the wireless devices are enabled at the factory, use the
wireless key to turn on or turn off the wireless devices
simultaneously.

(4)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(5)

Embedded numeric keypad keys

Can be used like the keys on an external numeric keypad when
pressed in combination with the fn and the num lk keys.

Chapter 2 External component identification

Component

Description

(1)

esc key

Displays system information when pressed in combination with the
fn key.

(2)

fn key

Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc key.

(3)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(4)

Embedded numeric keypad keys

Can be used like the keys on an external numeric keypad when
pressed in combination with the fn and the num lk keys.

(5)

Wireless key

Because the wireless devices are enabled at the factory, use the
wireless key to turn on or turn off the wireless devices
simultaneously.

Top Components
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Front components

Component

Description

(1)

Supports the following optional digital card formats:

(2)

SD Card Reader

Audio-out (headphone) jack

●

MultiMediaCard (MMC)

●

MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)

●

Secure Digital (SD) Memory Card

●

Secure Digital High Capacity (SDHC) Memory Card

●

Secure Digital High Speed (SDHS) Memory Card

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.
NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(3)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

Right-side components
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Component

Description

(1)

USB ports (2)

Connect optional USB devices.

(2)

RJ-11 (modem) jack (select models only)

Connects a modem cable.

(3)

Optical drive (select models only)

Reads optical discs and, on select models, also writes to optical
discs.

Chapter 2 External component identification

Component

Description

(4)

Optical drive light (select models only)

Blinking: The optical drive is being accessed.

(5)

Optical drive button (select models only)

Opens the optical drive tray.

Right-side components
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Left-side components

Component

Description

(1)

ExpressCard slot

Supports optional ExpressCards.

(2)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a deterrent, but it
may not prevent the computer from being mishandled or stolen.

(3)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.
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(4)

External monitor port

Connects an external VGA monitor or projector.

(5)

Battery light

●

Amber: A battery is charging.

●

Turquoise: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the lights turn off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(6)

Power connector

Connects an AC adapter.

(7)

RJ-45 (network) jack

Connects a network cable.

(8)

HDMI port

Connects an optional HDMI device.

(9)

USB port (1)

Connects optional USB device.

Chapter 2 External component identification

Bottom components

Component

Description

(1)

Battery release latches (2)

Release the battery from the battery bay.

(2)

Battery bay

Holds the battery.

Bottom components
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Component

Description

(3)

Enable airflow to cool internal components.

Vents (3)

NOTE: The computer fan starts up automatically to cook internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.
(4)

Memory module compartment

Contains the memory module slot.

WLAN module compartment

Contains the wireless LAN module slot.
CAUTION: To prevent an unresponsive system and the display
of a warning message, replace the WLAN module with only a
module authorized for use in the computer by the governmental
agency that regulates wireless devices in your country. If you
replace the module and then receive a warning message, remove
the module to restore computer functionality, and then contact
technical support.

Hard drive bay

Multimedia components
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Holds the hard drive.

Component

Description

(1)

Webcam light (select models only)

On: The webcam is in use.

(2)

Webcam (select models only)

Records audio and video and captures still photographs.

(3)

Integrated microphone

Records sound.

(4)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(5)

Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.
NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(6)

Speaker

Produces sound.

Multimedia components
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Wireless antennas (select models only)
On select computer models, at least 2 antennas send and receive signals from one or more wireless
devices. These antennas are not visible from outside of the computer.

NOTE: For optimal transmission, keep the areas immediately around the antennas free from
obstructions.
To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.
Component

Description

(1)

WWAN antennas (2)* (select models only)

Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2)

WLAN antennas (2)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of Regulatory, Safety and Environmental Notices
that apply to your country or region. These notices are located in Help and Support.
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Additional hardware components

Component

Description

(1)

Power cord*

Connects an AC adapter to an AC outlet.

(2)

Battery*

Powers the computer when the computer is not plugged into
external power.

(3)

AC adapter

Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.

Additional hardware components
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.
(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.
(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for your computer.
(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Service tag
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Item

Description

(1)

Display assembly (includes microphone, 2 WLAN antenna transceivers and cables and, on select computer
models, 2 WWAN antenna transceivers and cables)
39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped without
webcam (1366×768 resolution)

605801-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped with
webcam (1366×768 resolution)

605802-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers without webcam
(1366×768 resolution)

605803-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers with webcam
(1366×768 resolution)

605804-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped with
webcam, red (1366×768 resolution)

626124-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped without
webcam, red (1366×768 resolution)

626123-001

39.6-cm (15.6-in) HD BrightView display assembly with LED back lighting for use in
computers equipped with webcam, red (1366×768 resolution)

626126-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers equipped without
webcam, red (1366×768 resolution)

626125-001

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers without webcam
(1366×768 resolution)

605805-001

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers equipped with
webcam (1366×768 resolution)

605806-001

35.6-cm (14.0-in) HD BrightView display assembly for use in computers without webcam
(1366×768 resolution)

605807-001

35.6-cm (14.0-in) HD BrightView display assembly for use in computers equipped with
webcam (1366×768 resolution)

605808-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN but
without webcam (1366×768 resolution)

605809-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and
webcam (1366×768 resolution)

605810-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN but
without webcam (1366×768 resolution)

605811-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN and
webcam (1366×768 resolution)

605812-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and
webcam, red (1366×768 resolution)

616598-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and
without webcam, red (1366×768 resolution)

616597-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN and
without webcam, red (1366×768 resolution)

616599-001

Computer major components
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Item

Description
33.8-cm (13.3-in) HD BrightView display assembly with LED back lighting for use in
computers with WLAN and webcam, red (1366×768 resolution)

(2)

Keyboard
NOTE:

(3)

For a detailed list of available keyboards, see Sequential part number listing on page 40.

For use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605813-xxx

For use in 39.6-cm (15.6-in) computers

605814-xxx

Palm rest (includes TouchPad but not TouchPad board and cables)
For use in Compaq 33.8-cm (13.3-in) computers

605779-001

For use in Compaq 33.8-cm (13.3-in) computers, red

616602-001

For use in HP 35.6-cm (14.0-in) computers

605780-001

For use in Compaq 35.6-cm (14.0-in) computers

605781-001

For use in HP 39.6-cm (15.6-in) computers

605782-001

For use in Compaq 39.6-cm (15.6-in) computers

605783-001

For use in Compaq 39.6-cm (15.6-in) computers, red

626095-001

(4)

TouchPad board

605795-001

(5)

Top cover

(6)

(7)

Top cover for Compaq 33.8-cm (13.3-in) computers

605774-001

Top cover for Compaq 33.8-cm (13.3-in) computers, red

616601-001

Top cover for HP 35.6-cm (14.0-in) computers

605775-001

Top cover for Compaq 35.6-cm (14.0-in) computers

605776-001

Top cover for HP 39.6-cm (15.6-in) computers

605777-001

Top cover for Compaq 39.6-cm (15.6-in) computers

605778-001

Top cover for Compaq 39.6-cm (15.6-in) computers, red

626093-001

Heat sink
For use in computers with UMA graphics subsystems

605749-001

For use in computers with discrete graphics subsystems

605750-001

Fan
Fan for use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605787-001

Fan for use in 39.6-cm (15.6-in) computers computers

605791-001

(8)

Power switch board

605794-001

(9)

System board (includes RTC battery and replacement thermal material)
System board with discrete graphics and RTC battery with PM45 chipset having 1066-MHz
FSB
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605746-001

Item

(10)

Description
System board with Park XT discrete graphics and RTC battery with PM45 chipset having
1066-MHz FSB (for use in APJ only)

625491-001

System board with UMA graphics and RTC battery with GM45 chipset having 1066-MHz FSB

605747-001

System board with UMA graphics and RTC battery with GL40 chipset having 1066-MHz FSB

605748-001

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit , spare part number 599807-001. See
Cables on page 36 for more Cable Kit spare part information.
For use in all countries and regions except Australia and New Zealand (replaced by
628824-001)

510100-001

For use only in Australia and New Zealand (replaced by 628824-001)

510100-011

For use in all countries and regions (replaces 510100-001 and 510100-011)

628824-001

(11)

RTC battery

449137-001

(12)

Hard drive extender

605798-001

(13)

Optical drive extender
For use in 39.6-cm (15.6-in) computers

605799-001

For use in 35.6-cm (14.0-in) computers

605800-001

(14)

USB board with cable

605796-001

(15)

Bluetooth module

537921-001

HP Integrated module with Bluetooth 2.1 wireless technology For use in Andorra,
Argentina, Australia, Austria, Bangladesh, Belarus, Belgium, Bermuda, Brazil, Brunei,
Bulgaria, Canada, Cayman Islands, Chile, China, Croatia, Cyprus, Czech Republic,
Denmark, Egypt, El Salvador, Estonia, Finland, France, Germany, Greece, French Guiana,
Guadeloupe, Guam, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Japan, Jordan, South Korea, Latvia, Puerto Rico, Liechtenstein, Lithuania, Luxembourg,
Malaysia, Malta, Martinique, Mexico, Morocco, Netherlands, New Zealand, Norway,
Pakistan, Panama, Peru, Philippines, Poland, Portugal, Romania, Russia, Saudi Arabia,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Taiwan,
Thailand, Tunisia, Turkey, Ukraine, United Arab Emirates, the United Kingdom, the United
States, Venezuela, Virgin Islands
(16)

Processor (includes replacement thermal material) (not illustrated)
Intel® processor
Celeron® T3000, 1.8-GHz, 800 MHz FSB, 1-MB cache

572926-001

Celeron® T3300, 2.0-GHz, 800 MHz FSB, 1-MB cache

592399-001

Pentium T4500, 2.3-GHz, 800 MHz FSB, 1-MB cache

591880-001

Celeron® T1600, 1.66-GHz, 800 MHz FSB, 1-MB cache

532324-001

Celeron® T1700, 1.83-GHz, 800 MHz FSB, 1-MB cache

534084-001

Celeron® T3100, 1.9-GHz, 800 MHz FSB, 1-MB cache

572925-001

Computer major components
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Item

Description
Celeron® 900, 2.2-GHz,800 MHz FSB, 1-MB cache

534419-001

Pentium T4200, 2.0-GHz, 800 MHz FSB, 1-MB cache

513599-001

Pentium T4300, 2.1-GHz, 800 MHz FSB, 1-MB cache

572929-001

Pentium T4400, 2.2-GHz, 800 MHz FSB, 1-MB cache

584296-001

Core™ 2 Duo, T5870, 2.0-GHz, 800 MHz FSB, 2-MB cache

535835-001

Core™ 2 Duo, T6570, 2.1-GHz, 800 MHz FSB, 2-MB cache

513598-001

Core™ 2 Duo, T6670, 2.2-GHz, 800 MHz FSB, 2-MB cache

572927-001

Core™ 2 Duo, P7370, 2.0-GHz, 800 MHz FSB, 2-MB cache

507966-001

Core™ 2 Duo, P7570, 2.26-GHz, 1066 MHz FSB, 3-MB cache

572930-001

(17)

Speaker

605792-001

(18)

Audio board

605797-001

(19)

Base enclosure

(20)

(21)

(22)

For use in 33.8-cm (13.3-in) computers

605771-001

For use in 35.6-cm (14.0-in) computers

605772-001

For use in 39.6-cm (15.6-in) computers

605773-001

Battery
9-cell, 93-Wh, 2.8-Ah

593573-001

6-cell, 47-Wh, 2.2-Ah

593572-001

Memory module
4-GB (PC3-10600, 1333-MHz, DDR3

599092-002

2-GB (PC3-10600, 1333-MHz, DDR3)

598856-001

1-GB (PC3-10600, 1333-MHz, DDR3)

598859-001

WLAN module
Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter

593836-001

Broadcom 4312G 802.11b/g WiFi adapters:
●
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504593-003

Item

Description
●

(23)

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module: For use in Andorra, Antigua
and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados,
Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman
Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast,
Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco,
Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore,
Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland,
Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United Arab Emirates, the United
Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam
(replaced by 600370-001)

572520-001

Broadcom 4313 802.11b/g/n (1x1) WiFi Adapter and 2070 Bluetooth 2.1
and EDR Combo Adapter for use in all countries and regions (replaces 572520-001)

600370-001

Ralink RT3090 802.11b/g/n WiFi Adapter and Bluetooth and EDR Combo
Adapter for use in all countries and regions

602992-001

Atheros 9285G 802.11b/g/n WiFi Adapter for use in all countries and regions

605560-005

Realtek RTL8191SE 802.11b/g/n WiFi Adapter for use in all countries and regions

593533-001

Hard drive (includes hard drive bracket and rubber/foam bumper)
500-GB, 7200-rpm (replaces 614958-001)

608139-001

500-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 614523-001)

611029-001

Computer major components
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Item

(24)

(25)

32

Description
320-GB, 7200-rpm (replaces 614957-001)

608138-001

320-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 614955-001)

611028-001

250-GB, 7200-rpm (replaces 617441-001)

608137-001

250-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers

611027-001

250-GB, 5400-rpm

493994-001

160-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 615844-001)

614522-001

160-GB, 7200-rpm

455954-001

160-GB, 7200-rpm

652166-001

Optical drive (includes bezel)
DVD-ROM Drive

608140-001

DVD±RW Double-Layer Drive with LightScribe

608141-001

Access door
For use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605784-001

For use in 39.6-cm (15.6-in) computers

605785-001
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Display assembly components

Item

Description

(1)

Display bezel

(2)

Spare part number

Compaq 33.8-cm (13.3-in) LCD bezel without webcam

605751-001

Compaq 33.8-cm (13.3-in) LCD bezel with webcam

605752-001

HP 35.6-cm (14.0-in) LCD bezel without webcam

605753-001

HP 35.6-cm (14.0-in) LCD bezel with webcam

605754-001

Compaq 35.6-cm (14.0-in) LCD bezel without webcam

605755-001

Compaq 35.6-cm (14.0-in) LCD bezel with webcam

605756-001

HP 39.6-cm (15.6-in) LCD bezel without webcam

605757-001

HP 39.6-cm (15.6-in) LCD bezel with webcam

605758-001

Compaq 39.6-cm (15.6-in) LCD bezel without webcam

605759-001

Compaq 39.6-cm (15.6-in) LCD bezel with webcam

605760-001

Display Hinge Kit
Hinge Kit for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers

605768-001

Display assembly components
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Item

34

Description

Spare part number

Hinge Kit for 39.6-cm (15.6-in) computers

605769-001

(3)

Webcam module

611026-001

(4)

Display panel
Display panel AntiGlare without webcam for use in 39.6-cm (15.6-in) computers

608142-001

Display panel AntiGlare with webcam for use in 39.6-cm (15.6-in) computers

608143-001

Display panel BrightView without webcam for use in 39.6-cm (15.6-in) computers

608144-001

Display panel BrightView with webcam for use in 39.6-cm (15.6-in) computers

608145-001

Display panel AntiGlare without webcam for use in 35.6-cm (14-in) computers

608146-001

Display panel AntiGlare with webcam for use in 35.6-cm (14-in) computers

608147-001

Display panel BrightView with webcam for use in 35.6-cm (14-in) computers

608149-001

Display panel BrightView without webcam for use in 35.6-cm (14-in) computers

608148-001

Display panel AntiGlare, LED back lighting, LVDS for use with 39.6-cm (15.6-in)
computers in APJ only

623181-001

Display panel BrightView, LED back lighting, LVDS for use with 39.6-cm (15.6-in)
computers in APJ only

623182-001

Display panel AntiGlare, LED back lighting, LVDS for use with 35.6-cm (14-in)
computers computers in APJ only

623176-001

Display panel BrightView, LED back lighting, LVDS for use with 35.6-cm (14-in)
computers computers in APJ only

592144-001

Display panel AntiGlare, LED back lighting, LVDS for use with 33.8-cm (13.3-in)
computers in APJ only

623175-001

Display panel BrightView, LED back lighting for use with 33.8-cm (13.3-in) computers
in APJ only

588160-001

(5)

WLAN transceiver cable

spared with display
assembly

(6)

LCD cable
LCD cable with webcam

605767-001

LCD cable without webcam

605766-001

(7)

Microphone cable

(8)

Display enclosure
For use in Compaq 33.8-cm (13.3-in) computers

605761-001

For use in HP 35.6-cm (14.0-in) computers

605762-001

For use in Compaq 35.6-cm (14.0-in) computers

605763-001

For use in HP 39.6-cm (15.6-in) computers

605764-001
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Item

Description

Spare part number

For use in Compaq 39.6-cm (15.6-in) computers

605765-001

For use in Compaq 39.6-cm (15.6-in) computers, red

626094-001

Plastics Kit

Item

Description

Spare part number

Plastics Kit:

605786-001

(1)

Dummy ExpressCard

(2)

Dummy optical drive

Plastics Kit
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Cables

Item

36

Description

Spare part number

Cable Kit , includes:

605793-001

(1)

Bluetooth cable

(2)

RJ-11 cable

(3)

Main battery connector
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Item

Description

Spare part number

(1)

WLAN transceiver with cable

spared with display
assembly

(2)

Microphone cable

spared with display
assembly

(3)

LCD Cable Kit

(4)

LCD Cable without webcam ( not shown)

605766-001

LCD Cable with webcam cable

605767-001

USB cable

605796-001

Mass storage devices

Item

Description

(1)

Hard drive (includes bracket and foam bumper)

Spare part number

500-GB, 7200-rpm (replaces 614958-001)

608139-001

500-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 614523-001 and
614956-001)

611029-001

320-GB, 7200-rpm (replaces 614957-001)

608138-001

320-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 614955-001)

611028-001

250-GB, 7200-rpm (replaces 617441-001)

608137-001

250-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers

611027-001

Mass storage devices
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Item

(2)

Description

Spare part number

250-GB, 5400-rpm

493994-001

160-GB, 7200–rpm for use in 39.6-cm (15.6-in) computers (replaces 615844-001)

614522-001

160-GB, 7200-rpm

455954-001

160-GB, 7200–rpm

652166-001

Optical drive (includes bezel)
DVD±RW Double-Layer Drive with LightScribe

608140-001

DVD-ROM Drive

608141-001

Hard drive hardware kit for use in 39.6-cm (15.6-in) computers (not illustrated). For
use with replacement hard drives that do not come with mounting bracket, mounting
screws, and foam/rubber bumpers; includes:

652169-001

Hard drive mounting bracket
Hard drive retaining screw M3×3×4.5 (4)
Rubber bumper, 15×5×3mm (2)
Silicone bumper, 12×5.5×7mm (2)
Hard drive hardware kit for use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in)
computers (not illustrated). For use with replacement hard drives that do not come with
mounting bracket, mounting screws, and foam/rubber bumpers; includes:
Hard drive mounting bracket
Hard drive retaining screw M3×3×4.5 (4)
Foam bumper, 90×8×0.5mm
Rubber bumper, 13×9.5×3.1mm (2)
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652168-001

Miscellaneous parts
Description

Spare part number

AC adapters
65-W AC adapter for use with computers with UMA graphics

613149-001

90-W AC adapter for use with computers with discrete graphics

613150-001

Power cords
For use in Argentina

490371-D01

For use in Australia and New Zealand

490371-011

For use in Brazil

490371-201

For use in Denmark

490371-081

For use in Europe, the Middle East, and Africa

490371-021

For use in India

490371-D61

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in the United Kingdom

490371-031

For use in the United States

490371-001

Screw Kit, includes:

605790-001

●

(15) Torx 2.5×6.0 screws

●

(15) Phillips 2.5×4.5 screws

●

(15) Phillips 2.5×4.5 screws

●

(15) Phillips 2.5×4.5 screws

●

(15) Phillips 2.0×3.0 screws

●

(15) Phillips 3.0×4.5 screws

Rubber Kit (contains: 10 top bumper strips, 20 bottom case hinge bumpers, 10 rubber feet, 10
middle body bumpers, 10 RJ-11 bumpers, 10 bottom case bumpers)
For use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605789-001

For use in 39.6-cm (15.6-in) computers

608931-001

Miscellaneous parts
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Sequential part number listing

40

Spare part
number

Description

449137-001

RTC battery

490371-001

Power cord for use in the United States

490371-021

Power cord for use in Europe, the Middle East, and Africa

490371-031

Power cord for use in the United Kingdom

490371-061

Power cord for use in Italy

490371-081

Power cord for use in Denmark

490371-111

Power cord for use in Switzerland

490371-201

Power cord for use in Brazil

490371-291

Power cord for use in Japan

490371-AR1

Power cord for use in South Africa

490371-BB1

Power cord for use in Israel

490371-D01

Power cord for use in Argentina

504593-003

Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

504593-004

Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

507966-001

Intel® Core™ 2 Duo, P7370, 2.0-GHz, 800 MHz FSB, 2-MB cache

510100-001

Modem module for use in all countries and regions except Australia and New Zealand

510100-011

Modem module for use in Australia and New Zealand
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Spare part
number

Description

513598-001

Intel® Core™ 2 Duo, T6570, 2.1-GHz, 800 MHz FSB, 2-MB cache

513599-001

Intel® Pentium T4200, 2.0-GHz, 800 MHz FSB, 1-MB cache

532324-001

Intel® Celeron® T1600, 1.66-GHz, 800 MHz FSB, 1-MB cache

534084-001

Intel® Celeron® T1700, 1.83-GHz, 800 MHz FSB, 1-MB cache

534419-001

Intel® Celeron® 900, 2.2-GHz,800 MHz FSB, 1-MB cache

535835-001

Intel® Core™ 2 Duo, T5870, 2.0-GHz, 800 MHz FSB, 2-MB cache

537921-001

Bluetooth module with Bluetooth 2.1 wireless technology

572520-001

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina,
Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan,
Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad
and Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin
Islands, Venezuela, and Vietnam (replaced by 600370-001)

572925-001

Intel® Celeron® T3100, 1.9-GHz, 800 MHz FSB, 1-MB cache

572926-001

Intel® Celeron® T3000, 1.8-GHz, 800 MHz FSB, 1-MB cache

572927-001

Intel® Core™ 2 Duo, T6670, 2.2-GHz, 800 MHz FSB, 2-MB cache

572929-001

Intel® Pentium T4300, 2.1-GHz, 800 MHz FSB, 1-MB cache

572930-001

Intel® Core™ 2 Duo, P7570, 2.26-GHz, 1066 MHz FSB, 3-MB cache

588160-001

Display panel BrightView, LED back lighting for use with33.8-cm (13.3-in) computers in APJ only

584296-001

Intel® Pentium T4400, 2.2-GHz, 800 MHz FSB, 1-MB cache

592144-001

Display panel BrightView, LED back lighting, LVDS for use with 35.6-cm (14-in) computers computers in APJ
only

591880-001

Intel® Pentium T4500, 2.3-GHz, 800 MHz FSB, 1-MB cache

592399-001

Intel® Celeron® T3300, 2.0-GHz, 800 MHz FSB, 1-MB cache

593533-001

Realtek RTL8191SE 802.11b/g/n WiFi Adapter

593572-001

Battery, 6-cell, 47 Wh, 2.2 Ah for use in computers with 15.6-in displays

593573-001

Battery, 9-cell, 93 Wh, 2.8 Ah for use in computers with 15.6-in displays

593836-001

Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter

598856-001

2-GB (PC3-10600, 1333-MHz, DDR3)

598859-001

1-GB (PC3-10600, 1333-MHz, DDR3

Sequential part number listing
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Spare part
number

Description

599092-002

4-GB (PC3-10600, 1333-MHz, DDR3

600370-001

Broadcom 4313 802.11b/g/n (1x1) WiFi Adapter and 2070 Bluetooth 2.1 and EDR Combo Adapter for
use in all countries and regions

602992-001

Ralink RT3090 802.11b/g/n WiFi Adapter and Bluetooth and EDR Combo Adapter for use in all countries
and regions

605660-005

Atheros 9285G 802.11b/g/n WiFi Adapter

605746-001

System board with discrete graphics and RTC battery with PM45 chipset having 1066-MHz FSB

605747-001

System board with UMA graphics and RTC battery with GM45 chipset having 1066-MHz FSB

605748-001

System board with UMA graphics and RTC battery with GL40 chipset having 1066-MHz FSB

605749-001

Heat sink for use in computers with UMA graphics subsystems

605750-001

Heat sink for use in computers with discrete graphics subsystems

605751-001

Compaq 33.8-cm (13.3-in) LCD bezel without webcam

605752-001

Compaq 33.8-cm (13.3-in) LCD bezel with webcam

605753-001

HP 35.6-cm (14.0-in) LCD bezel without webcam

605754-001

HP 35.6-cm (14.0-in) LCD bezel with webcam

605755-001

Compaq 35.6-cm (14.0-in) LCD bezel without webcam

605756-001

Compaq 35.6-cm (14.0-in) LCD bezel with webcam

605757-001

HP 39.6-cm (15.6-in) LCD bezel without webcam

605758-001

HP 39.6-cm (15.6-in) LCD bezel with webcam

605759-001

Compaq 39.6-cm (15.6-in) LCD bezel without webcam

605760-001

Compaq 39.6-cm (15.6-in) LCD bezel with webcam

605761-001

Compaq 33.8-cm (13.3-in) display enclosure

605762-001

HP 35.6-cm (14.0-in) display enclosure

605763-001

Compaq 35.6-cm (14.0-in) display enclosure

605764-001

HP 39.6-cm (15.6-in) display enclosure

605765-001

Compaq 39.6-cm (15.6-in) display enclosure

605766-001

LCD cable without webcam

605767-001

LCD cable with webcam

605768-001

Hinge Kit for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers

605769-001

Hinge Kit for 39.6-cm (15.6-in) computers

605771-001

Base enclosure for 33.8-cm (13.3-in) computers

605772-001

Base enclosure for 35.6-cm (14.0-in) computers

605773-001

Base enclosure for 39.6-cm (15.6-in) computers
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Spare part
number

Description

605774-001

Top cover for Compaq 33.8-cm (13.3-in) computers

605775-001

Top cover for HP 35.6-cm (14.0-in) computers

605776-001

Top cover for Compaq 35.6-cm (14.0-in) computers

605777-001

Top cover for HP 39.6-cm (15.6-in) computers

605778-001

Top cover for Compaq 39.6-cm (15.6-in) computers

605779-001

Palm rest with TouchPad for Compaq 33.8-cm (13.3-in) computers (does not include TouchPad board and
cable)

605780-001

Palm rest with TouchPad for HP 35.6-cm (14.0-in) computers (does not include TouchPad board and cable)

605781-001

Palm rest with TouchPad for Compaq 35.6-cm (14.0-in) computers (does not include TouchPad board and
cable)

605782-001

Palm rest with TouchPad for HP 39.6-cm (15.6-in) computers (does not include TouchPad board and cable)

605783-001

Palm rest with TouchPad for Compaq 39.6-cm (15.6-in) computers (does not include TouchPad board and
cable)

605784-001

Service door for 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605785-001

Service door for 39.6-cm (15.6-in) computers

605786-001

Plastics Kit

605787-001

Fan for use in 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605789-001

Rubber Kit for 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers

605790-001

Screw Kit

605791-001

Fan for use in 39.6-cm (15.6-in) computers

605792-001

Speaker

605793-001

Cable Kit

605794-001

Power switch board

605795-001

TouchPad board

605796-001

USB board

605797-001

Audio board

605798-001

Hard drive extender

605799-001

Optical drive extender for 39.6-cm (15.6-in) computers

605800-001

Optical drive extender for 35.6-cm (14.0-in) computers

605801-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped without webcam
(1366×768 resolution)

605802-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped with webcam (1366×768
resolution)

Sequential part number listing
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number
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605803-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers without webcam (1366×768
resolution)

605804-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers with webcam (1366×768
resolution)

605805-001

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers without webcam (1366×768
resolution)

605806-001

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers equipped with webcam (1366×768
resolution)

605807-001

35.6-cm (14.0-in) HD BrightView display assembly for use in computers without webcam (1366×768
resolution)

605808-001

35.6-cm (14.0-in) HD BrightView display assembly for use in computers equipped with webcam
(1366×768 resolution)

605809-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN but without webcam
(1366×768 resolution)

605810-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and webcam
(1366×768 resolution)

605811-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN but without webcam
(1366×768 resolution)

605812-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN and webcam
(1366×768 resolution)

605813-001

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in the United States

605813-031

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in the United Kingdom

605813-041

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Germany

605813-051

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in France

605813-061

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Italy

605813-071

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Spain

605813-081

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Denmark

605813-091

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Norway

605813-121

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in French Canada

605813-131

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Portugal

605813-141

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Turkey

605813-161

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Latin America

605813-171

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Saudi Arabia

605813-201

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Brazil

605813-211

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Hungary

605813-251

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Russia
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605813-261

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Bulgaria

605813-281

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Thailand

605813-291

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Japan

605813-A41

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Europe

605813-A81

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in the Czech Republic

605813-AB1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Taiwan

605813-AD1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in South Korea

605813-B31

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for International use

605813-B71

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Finland

605813-BA1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Slovenia

605813-BB1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Israel

605813-BG1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Switzerland

605813-DD1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Iceland

605813–DH1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in the Netherlands

605813-DJ1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in Greece

605813-DW1

Keyboard for 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers for use in the French Arabic region

605814-001

Keyboard for 39.6-cm (15.6-in) computers for use in the United States

605814-031

Keyboard for 39.6-cm (15.6-in) computers for use in the United Kingdom

605814-041

Keyboard for 39.6-cm (15.6-in) computers for use in Germany

605814-051

Keyboard for 39.6-cm (15.6-in)) computers for use in France

605814-061

Keyboard for 39.6-cm (15.6-in) computers for use in Italy

605814-071

Keyboard for 39.6-cm (15.6-in) computers for use in Spain

605814-081

Keyboard for 39.6-cm (15.6-in) computers for use in Denmark

605814-091

Keyboard for 39.6-cm (15.6-in) computers for use in Norway

605814-121

Keyboard for 39.6-cm (15.6-in) computers for use in French Canada

605814-131

Keyboard for 39.6-cm (15.6-in) computers for use in Portugal

605814-141

Keyboard for 39.6-cm (15.6-in) computers for use in Turkey

605814-161

Keyboard for 39.6-cm (15.6-in) computers for use in Latin America

605814-171

Keyboard for 39.6-cm (15.6-in) computers for use in Saudi Arabia

605814-201

Keyboard for 39.6-cm (15.6-in) computers for use in Brazil

605814-211

Keyboard for 39.6-cm (15.6-in) computers for use in Hungary

605814-251

Keyboard for 39.6-cm (15.6-in)) computers for use in Russia
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605814-261

Keyboard for 39.6-cm (15.6-in) computers for use in Bulgaria

605814-281

Keyboard for 39.6-cm (15.6-in) computers for use in Thailand

605814-291

Keyboard for 39.6-cm (15.6-in) computers for use in Japan

605814-A41

Keyboard for 39.6-cm (15.6-in) computers for use in Europe

605814-A81

Keyboard for 39.6-cm (15.6-in) computers for use in the Czech Republic

605814-AB1

Keyboard for 39.6-cm (15.6-in) computers for use in Taiwan

605814-AD1

Keyboard for 39.6-cm (15.6-in) computers for use in South Korea

605814-B31

Keyboard for 39.6-cm (15.6-in) computers for International use

605814-B71

Keyboard for 39.6-cm (15.6-in) computers for use in Finland

605814-BA1

Keyboard for 39.6-cm (15.6-in) computers for use in Slovenia

605814-BB1

Keyboard for 39.6-cm (15.6-in) computers for use in Israel

605814-BG1

Keyboard for 39.6-cm (15.6-in) computers for use in Switzerland

605814-DD1

Keyboard for 39.6-cm (15.6-in) computers for use in Iceland

605814–DH1

Keyboard for 39.6-cm (15.6-in) computers for use in the Netherlands

605814-DJ1

Keyboard for 39.6-cm (15.6-in) computers for use in Greece

605814-DW1

Keyboard for 39.6-cm (15.6-in) computers for use in the French Arabic region

608137-001

250-GB, 7200-rpm hard drive for use in computers with 35.6-cm (14-in) or 33.8-cm (13.3-in) (replaces
617441-001)

608138-001

320-GB, 7200-rpm hard drive for use in computers with 35.6-cm (14-in) or 33.8-cm (13.3-in) (replaces
614957-001)

608139-001

500-GB, 7200-rpm hard drive for use in computers with 35.6-cm (14-in) or 33.8-cm (13.3-in) (replaces
614958-001)

608140-001

DVD RW with LightScribe

608141-001

DVD

608142-001

Display panel AntiGlare without webcam for use in 39.6-cm (15.6-in) computers

608143-001

Display panel AntiGlare with webcam for use in 39.6-cm (15.6-in) computers

608144-001

Display panel BrightView without webcam for use in 39.6-cm (15.6-in) computers

608145-001

Display panel BrightView with webcam for use in 39.6-cm (15.6-in) computers

608146-001

Display panel AntiGlare without webcam for use in 35.6-cm (14-in) computers

608147-001

Display panel AntiGlare with webcam for use in 35.6-cm (14-in) computers

608148-001

Display panel BrightView without webcam for use in 35.6-cm (14-in) computers

608149-001

Display panel BrightView with webcam for use in 35.6-cm (14-in) computers

608931-001

Rubber Kit for 39.6-cm (15.6-in) computers
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Spare part
number

Description

611026-001

Webcam

611027-001

250-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays

611028-001

320-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays (replaces 614955-001)

611029-001

500-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays (replaces 614523-001)

613149-001

65-W AC adapter for use with computers with UMA graphics

613150-001

90-W AC adapter for use with computers with discrete graphics

614522-001

160-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays (replaces 615844-001)

616597-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and without webcam,
red (1366×768 resolution)

616598-001

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and webcam, red
(1366×768 resolution)

616599-001

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN and without webcam,
red (1366×768 resolution)

616600-001

33.8-cm (13.3-in) HD BrightView display assembly with LED back lighting for use in computers with WLAN
and webcam, red (1366×768 resolution)

616601-001

Top cover for Compaq 33.8-cm (13.3-in) computers, red

623175-001

Display panel AntiGlare, LED back lighting, LVDS for use with 33.8-cm (13.3-in) computers in APJ only

623176-001

Display panel AntiGlare, LED back lighting, LVDS for use with 33.8-cm (13.3-in) computers in APJ only

623181-001

Display panel AntiGlare, LED back lighting, LVDS for use with 39.6-cm (15.6-in) computers in APJ only

623182-001

Display panel BrightView, LED back lighting, LVDS for use with 39.6-cm (15.6-in) computers in APJ only

616602-001

Palm rest with TouchPad for use with 33.8-cm (13.3-in) computers, red

617441-001

250-GB, 5400-rpm hard drive (replaced by 608137-001)

625491-001

System board, Park XT, with discrete graphics and RTC battery with PM45 chipset having 1066-MHz FSB (for
use in APJ only)

626094-001

Display enclosure for use in Compaq 39.6-cm (15.6-in) computers, red

626093-001

Top cover for Compaq 39.6-cm (15.6-in) computers, red

626095-001

Palm rest with TouchPad for use with 39.6-cm (15.6-in) computers, red

626123-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped without webcam, red
(1366×768 resolution)

626124-001

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped with webcam, red
(1366×768 resolution)

626125-001

39.6-cm (15.6-in) HD BrightView display assembly for use in computers equipped without webcam, red
(1366×768 resolution)

626126-001

39.6-cm (15.6-in) HD BrightView display assembly with LED back lighting for use in computers equipped
with webcam, red (1366×768 resolution)

628824-001

Modem module for use in all countries and regions (replaces 510100-001 and 510100-011)
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Spare part
number

Description

652166-001

160-GB, 7200-rpm hard drive

652168-001

Hard drive hardware kit for use with 33.8-cm (13.3-in) and 39.6-cm (14.0-in) computers

652169-001

Hard drive hardware kit for use with 39.6-cm (15.6-in) computers
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Removal and replacement
procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Preliminary replacement requirements
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This section provides removal and replacement procedures.
There are many screws, in many different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:
(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.
(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.
(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.
(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 605789-001 for 33.8-cm (13.3-in) and 35.6-cm (14.0-in) computers and in Rubber Kit
608931-001 for 39.6-cm (15.6-in) computers. There are 4 rubber feet that attach to the base
enclosure in the locations illustrated below.
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Battery
Description

Spare part number

9-cell, 93-Wh, 2.8-Ah Li-on battery

593573-001

6-cell, 47-Wh, 2.2-Ah Li-on battery

593572-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside down on a flat surface with the battery bay toward you.

2.

Slide the battery release latches (1) to release the battery.

3.

Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.

Service door
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Description

Spare part number

For use in computers with 39.6-cm (15.6-in) displays

605785-001

For use in computers with 35.6-cm (14-in) and 33.8-cm (13.3-in) displays

605874-001
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Before removing the service door follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

Remove the service door on a 39.6-cm (15.6-in) computer:
1.

Remove four Phillips PM2.0×3.0 screws (1) that secure the service door to the computer.

2.

Slide the service door (2) away from the computer.

Remove the service door on a 35.6-cm (14-in) or 33.8-cm (13.3-in) computer:
1.

Remove two Phillips PM2.0×3.0 screws (1) that secure the service door to the computer.
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2.

Slide the service door (2) away from the computer.

Reverse this procedure to install the switch cover.
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Hard drive
NOTE: The hard drive spare part kit includes a hard drive bracket.
Description

Spare part number

500-GB, 7200-rpm hard drive (replaces 614958-001)

608139-001

500-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays (replaces
614956-001 and 614523-001)

611029-001

320-GB, 7200 rpm (replaces 614957-001)

608138-001

320-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays (replaces
614955-001)

611028-001

250-GB, 7200-rpm (replaces 617441-001)

608137-001

250-GB, 7200-rpm hard drive for use in computers with 39.6-cm (15.6-in) displays

611027-001

250-GB, 5400-rpm

493994-001

160-GB, 7200-rpm for use in 39.6-cm (15.6-in) computers (replaces 615844-001)

614522-001

160-GB, 7200-rpm

455954-001

160-GB, 7200-rpm (replaces 651040-001)

652166-001

Before removing the hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the hard drive from a 39.6-cm (15.6-in) computer:
1.

Position the computer right-side up with the front toward you.

2.

Remove the two Phillips PM2.5×6.0 screws (1) and loosen the Phillips PM2.5×11.0 captive screw
(2) that secure the hard drive to the computer.

3.

Grasp the mylar tab on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.
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4.

Remove the hard drive (4) from the hard drive bay.

Remove the hard drive from a 35.6-cm (14-in) or 33.8-cm (13.3-in) computer:
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1.

Position the computer right-side up with the front toward you.

2.

Remove the two Phillips PM2.5×6.0 screws (1) and the Phillips PM2.5×4.0 screw (2) that secure
the hard drive to the computer.

3.

Grasp the mylar tab on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.

4.

Remove the hard drive (4) from the hard drive bay.
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To remove the hard drive bracket, follow these steps:
1.

If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.

2.

Lift the bracket (2) straight up to remove it from the hard drive.

It is necessary to attach rubber or foam bumpers to drives and/or hard drive brackets before installing
them in the computer.
For a 39.6-cm (15.6-in) computer using a 9.5mm thick hard drive, attach 2 pieces of 15×5×3mm
rubber from spares kit 652169-001 to the hard drive.

For a 39.6-cm (15.6-in) computer using a 7.0mm thick hard drive, attach 2 pieces of 12×5.5×7mm
rubber from spares kit 652169-001 to the hard drive.
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For a 35.6-cm (14-in) or 33.8-cm (13.3-in) computer, attach 1 piece of the 90× 8×0.5 mm rubber
bumper from spares kit 652168-001 to the outside of the hard drive bracket.

For a 35.6-cm (14-in) or 33.8-cm (13.3-in) computers using 7 mm thick hard drives, attach 2 pieces
of 13×9.5×3.1 mm rubber bumper from spares kit 652168-001 to the hard drive.

62

Chapter 4 Removal and replacement procedures

After the rubber or foam bumpers have been attached, reverse the removal procedure to install the
hard drive.
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Memory module
NOTE: When adding a second memory module, be sure it is the same type and speed as the
installed memory module.
Description

Spare part number

4-GB (PC3-10600, 1333-MHz, DDR3)

599092-002

2-GB (PC3-10600, 1333-MHz, DDR3)

598856-001

1-GB (PC3-10600, 1333-MHz, DDR3)

598859-001

Before removing the memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the memory module:
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1.

Position the computer right-side up with the front toward you.

2.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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WLAN module
Description

Spare part number

Broadcom 4312 802.11b/g WLAN modules
●

For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-003

●

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's
Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent
and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module
●
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For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria,
Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece,
Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius,
Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines,
Poland, Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United Arab
Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela,
and Vietnam (replaced by 600370–001)

572520-001

Broadcom 4313 802.11b/g/n (1x1) WiFi Adapter and 2070 Bluetooth and EDR
Combo Adapter for use in all countries and regions

600370-001

Ralinlk RT3090 802.11b/g/n (1x1) WiFi Adapter and Bluetooth and EDR Combo
Adapter for use in all countries and regions

602992-001

Broadcom 4313AGN 802.11a/b/g/draft-n WiFi Adapter

593836-0001
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Description

Spare part number

Atheros 9285G 802.11 b/g/n WiFi Adapter for use in all countries and regions

605560-005

Realtek RTL8191SE802.11 b/g/n WiFi Adapterf or use in all countries and regions

593533-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.
Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2.

Remove the two Phillips PM2.0×2.5 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WLAN module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.
Description

Spare part number

DVD±RW Double-Layer Drive with LightScribe (includes bezel)

608141-001

DVD-ROM Drive (includes bezel)

608140-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the optical drive:
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1.

Position the computer with the right side toward you.

2.

Remove the Phillips PM2.5×6.0 screw (1) that secures the optical drive to the computer.

3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right to release the optical drive from the computer.

4.

Remove the optical drive (3) from the computer.

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.
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6.

Remove the two Phillips PM2.0×2.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.

Fan
Description

Spare part number

Fan for use in 39.6-cm (15.6-in) computers

605791–001

Fan for use in 35.6-cm (14.0-in) and33.8-cm (13.3-in) computers

605787–001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the fan:
1.

Position the computer upside down with the front toward you.

2.

Disconnect the fan cable (1) from the system board .
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3.

Remove the Phillips PM2.0×3.0 screw (2) that secures the fan, and then remove the fan (3).

Reverse this procedure to install the fan.

Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.
Description

Spare part number

Heat sink for use in computers with UMA graphics subsystems

605749-001

Heat sink for use in computers with discrete graphics subsystems

605750-001

Before removing the heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the fan (see Fan on page 69).

Remove the heat sink on computers with UMA graphics subsystems:
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1.

Position the computer right-side up with the front facing you.

2.

Following the sequence stamped into the heat sink, loosen the captive screws (1) and (2) around
the processor.
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3.

Raise the end of the heat sink (3) to free it from the system board components and then remove
the heat sink (4) from the system board.

Remove the heat sink on computers with discrete graphics subsystems:
1.

Position the computer right-side up with the front facing you.

2.

Following the sequence stamped into the heat sink, loosen the captive screws (1) and (2) around
the processor.

3.

Lift the heat sink (3) from the system board.

Processor
NOTE: The processor spare part kit includes replacement thermal material.
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Description

Spare part number

Intel Celeron T1600, 1.66-GHz

532324-001

Intel Celeron T1700, 1.83-GHz

534084-001

Intel Celeron T3000, 1.8–GHz

572926-001

Intel Montevina T3100, 1.9-GHz

572925-001

Intel Montevina T3300, 2.0-GHz

592399-001

Intel Celeron 900, 2.2-GHz

534119-001

Intel Montevina T4200, 2.0-GHz

513599-001

Intel Montevina T4300, 2.1-GHz

572929-001

Intel Montevina T4500, 2.3-GHz

591880-001

Intel Montevina DC 2.2-GHz

584296-001

Intel Core 2 Duo T5870, 2.0-GHz

535835-001

Intel Montevina T6570, 2.1-GHz

513598-001

Intel Montevina T6670, 2.2-GHz

572927-001

Intel Montevina P7370, 2.0-GHz

507966-001

Intel Montevina P7570, 2.26-GHz

572930-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the fan (see Fan on page 69).

7.

Remove the heat sink (see Heat sink on page 70).

Remove the processor:
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1.

Position the computer right-side up with the front toward you.

2.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.
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3.

Lift the processor (2) straight up and remove it.
NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.

Palm rest
Description

Spare part number

Palm rest for Compaq units with 39.6-cm (15.6-in) displays (includes TouchPad)

605783-001

Palm rest for Compaq units with 39.6-cm (15.6-in) displays (includes TouchPad), red

626095-001

Palm rest for Compaq brand units with 35.6-cm (14-in) displays (includes TouchPad)

605781-001

Palm rest for Compaq brand units with 33.8-cm (13.3-in) displays (includes TouchPad)

605779-001

Palm rest for Compaq brand units with 33.8-cm (13.3-in) displays (includes TouchPad), red

616602-001

Palm rest for HP brand units with 39.6-cm (15.6-in) displays (includes TouchPad)

605782-001

Palm rest for HP brand units with 35.6-cm (14-in) displays (includes TouchPad)

605780-001
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Before removing the palm rest, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

Remove the palm rest on 39.6-cm (15.6-in) computers:
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1.

Position the computer upside down with the front toward you.

2.

Remove the two Torx M2.5×6.0 screws that secure the palm rest to the computer.

3.

Turn the computer over and pull up (1) on the top edge of the palm rest nearest the keyboard.
With the palm rest at an angle, slide the unit (2) to release the latches at its base.
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4.

Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
cable (2) from the system board.

5.

Remove the palm rest.

Remove the palm rest on 35.6-cm (14-in) or 33.8-cm (13.3-in) computers:
1.

Position the computer upside down with the front toward you.

2.

Remove the two Torx M2.5×6.0 screws (1) and one Philllips PM2.25×2.5 broadhead screw (2)
that secure the palm rest to the computer.
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3.

Turn the computer over, rotate the palm rest up (1) and slide the palm rest to the right (2) to
release it from the computer.

4.

Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
cable (2) from the system board.

5.

Remove the palm rest.

Remove the TouchPad board:
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1.

Lay the palm rest on a protected surface upside-down.

2.

Release the ZIF connector (1) and disconnect the cable (2 from the socket.
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3.

Remove the single screw (1) that secures the TouchPad board to the palm rest and lift the
TouchPad board (2) from the palm rest.

Reverse this procedure to install the TouchPad board.
Reverse this procedure to install the palm rest.
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Keyboard
Description

Spare part number

Keyboards for use in computers with 39.6-cm (15.6-in) displays

605813-xx1

Keyboards for use in computers with 35.6-cm (14.3-in) and 33.8-cm (13.3-in)
displays

605814-xx1

NOTE:

For a detailed list of available keyboards, see Sequential part number listing on page 40.

Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the palm rest (see Palm rest on page 73).

Remove the keyboard on 39.6-cm (15.6-in) computers:
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1.

Position the computer upside down with the rear toward you.

2.

Remove the three Phillips PM2.5×3.0 broadhead black screws (1) and three Torx M2.5×6.0
screws (2) that secure the keyboard.
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3.

Turn the unit over, lift the top edge of the keyboard (1) and slide it (2) towards the display.

4.

Rest the keyboard on its edge and slide the keyboard back toward the display then, release the
ZIF connector (1) to which the keyboard cable is attached, and disconnect the keyboard cable
(2) from the system board.

Remove the keyboard on 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers:
1.

Position the computer upside down with the rear toward you.
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2.

Remove two Phillips PM2.5×3.0 broadhead black screws (1), one Phillips PM2.5×3.0 broadhead
silver screw (2), and two Torx M2.5×6.0 screws (3) that secure the keyboard.

3.

Turn the unit over, lift the top edge of the keyboard (1) and slide it (2) towards the display.
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4.

Rest the keyboard on its edge and slide the keyboard back toward the display then, release the
ZIF connector (1) to which the keyboard cable is attached, and disconnect the keyboard cable
(2) from the system board.

Reverse this procedure to install the switch cover and keyboard.
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Top cover
Description

Spare part number

Top cover for use in Compaq brand computers with 39.6-cm (15.6-in) displays

605778-001

Top cover for use in Compaq brand computers with 39.6-cm (15.6-in) displays, red

626093-001

Top cover for use in Compaq brand computers with 35.6-cm (14.0-in) displays

605776-001

Top cover for use in Compaq brand computers with 33.8-cm (13.3-in) displays

605774-001

Top cover for use in Compaq brand computers with 33.8-cm (13.3-in) displays, red

616601-001

Top cover for use in HP brand computers with 39.6-cm (15.6-in) displays

605777-001

Top cover for use in HP brand computers with 35.6-cm (14.0-in) displays

605775-001

Before removing the top cover, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the palm rest (see Palm rest on page 73).

7.

Remove the keyboard (see Keyboard on page 78).
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Remove the top cover on a 39.6-cm (15.6-in) computer:
1.

With the display panel in the open position, press in (1) of the ExpressCard to release it and then
pull the card (2) from the computer.

2.

Position the computer upside down with the front toward you.

3.

Remove the nine Torx M2.5×6.0 screws (1), three Phillips PM2.5×3.0 black broadhead screws
(2), and three Phillips PM2.0×3.0 screws (3).
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4.

Turn the computer over so it is right-side up and remove four Torx M2.5×6.0 screws.

5.

Release the ZIF connector (1) and remove the power switch cable (2).
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6.

Rotate the top cover up (1) and remove it from the base enclosure (2).

Remove the top cover on a 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computer:
1.

With the display panel in the open position, press in (1) of the ExpressCard to release it and then
pull the card (2) from the computer.

2.

Position the computer upside down with the front toward you.
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3.

Remove the two Phillips PM2.0×2.0 screws (1) located in the battery bay, four Torx M2.5×6.0
screws (2), (3), and (4), and the two Phillips PM2.0×3.0 screws (5) located in the recess near
the optical drive.

4.

Turn the computer over so it is right-side up and remove five Torx M2.5×6.0 screws.

Chapter 4 Removal and replacement procedures

5.

Release the ZIF connector (1) and disconnect the power switch cable (2).

6.

Rotate the top cover up (1) and off the base enclosure (2).

Reverse this procedure to install the top cover.

Power switch board
The spare part number for the power switch board used in all models is 605794-001.
Before removing the power switch board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the keyboard (see Keyboard on page 78).

Remove the power switch board:
1.

Release the ZIF connector (1) and disconnect the ribbon cable (2) from the system board.

2.

Remove the Phillips M2.5×3.0 broadhead screw (1) that secures the board to the base pan, raise
the end of the board (2), and then slide the board out of the retainer (3).

Reverse this procedure to install the power button board.
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Bluetooth module
NOTE: The Bluetooth module spare part number is 537921-002 and is used in all countries and
regions except Japan and Asia Pacific countries and regions. The Bluetooth module cable is included in
the Cable Kit, spare part number 605793-001. See Cables on page 36 for more Cable Kit spare part
number information.
Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the palm rest (see Palm rest on page 73).

6.

Remove the keyboard (see Keyboard on page 78).

7.

Remove the top cover (see Top cover on page 82).

Remove the Bluetooth module on 39.6-cm (15.6-in) computers:
1.

Position the computer right-side up with the front toward you.

2.

Disconnect the Bluetooth cable (1) from the system board and remove the antenna (2) from the
base enclosure. The antenna is held to the base enclosure with adhesive.

Remove the Bluetooth module on 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers:
1.

Position the computer right-side up with the front toward you.
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2.

Disconnect the Bluetooth cable (1) from the system board and remove the antenna (2) from the
base enclosure. The antenna is held to the base enclosure with adhesive.

Reverse this procedure to install the Bluetooth module.

USB connector assembly
The spare part number for the USB connector assembly used on all models is 605796-0001.
Before removing the USB connector assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the palm rest (see Palm rest on page 73).

6.

Remove the keyboard (see Keyboard on page 78).

7.

Remove the top cover (see Top cover on page 82).

Remove the USB connector assembly on 39.6-cm (15.6-in) computers:
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1.

Position the computer right-side up with the right side toward you.

2.

Release the ZIF connector (1) and remove the cable (2) from the system board.
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3.

Remove the Torx M2.5×6.0 screw (3) then, lift the USB connector assembly (4) from the base
enclosure.

Remove the USB connector assembly on 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers:
1.

Position the computer right-side up with the right side toward you.

2.

Release the ZIF connector (1) and remove the cable (2) from the system board.

3.

Lift the USB connector assembly (3) that is held on the base enclosure with adhesive.

Reverse this procedure to install the USB connector assembly.
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Speaker
The spare part number for the speaker used in all models is 605792-001.
Before removing the speaker, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the palm rest (see Palm rest on page 73).

7.

Remove the keyboard (see Keyboard on page 78).

8.

Remove the top cover (see Top cover on page 82).

Remove the speaker:
1.

Disconnect the speaker cable from the connector (1) on the system board.

2.

Release the cable from the cable retainers (2) then, push up on the speaker from the back (3) to
remove it from the base enclosure.

Reverse this procedure to install the speaker.
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Display assembly
Description

Spare part number

●

39.6-cm (15.6-in) HD BrightView display assembly for use in computers equipped with
webcam (1366×768 resolution)

605804-001

●

39.6-cm (15.6-in) HD BrightView display assembly for use in computers without webcam
(1366×768 resolution)

605803-001

●

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers equipped with
webcam (1366×768 resolution)

605802-001

●

39.6-cm (15.6-in HD AntiGlare display assembly for use in computers equipped without
webcam (1366×768 resolution)

605801-001

●

39.6-cm (15.6-in) HD BrightView display assembly with LED back lighting for use in
computers with webcam (1366×768 resolution), red

626126-001

●

39.6-cm (15.6-in) HD BrightView display assembly for use in computers without webcam
(1366×768 resolution), red

626125-001

●

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers with webcam
(1366×768 resolution), red

626124-001

●

39.6-cm (15.6-in) HD AntiGlare display assembly for use in computers without webcam
(1366×768 resolution), red

626123-001

●

35.6-cm (14.0-in) HD BrightView display assembly for use in computers equipped with
webcam (1366×768 resolution)

605808-001

●

35.6-cm (14.0-in) HD BrightView display assembly for use in computers without webcam
(1366×768 resolution)

605807-001

●

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers equipped with
webcam (1366×768 resolution)

605806-001

●

35.6-cm (14.0-in) HD AntiGlare display assembly for use in computers without webcam
(1366×768 resolution)

605805-001

●

33.8-cm (13.3-in) HD BrightView display assembly for use in computers equipped with
webcam and WLAN (1366×768 resolution)

605812-001

●

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN but
without webcam (1366×768 resolution)

605811-001

●

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers equipped with
webcam and WLAN (1366×768 resolution)

605810-001

●

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN but
without webcam (1366×768 resolution)

605809-001

●

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and
webcam (1366×768 resolution), red

616598-001

●

33.8-cm (13.3-in) HD AntiGlare display assembly for use in computers with WLAN and
without webcam (1366×768 resolution), red

616597-001
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Description

Spare part number

●

33.8-cm (13.3-in) HD BrightView display assembly for use in computers with WLAN and
without webcam (1366×768 resolution), red

616599-001

●

33.8-cm (13.3-in) HD BrightView display assembly with LED back lighting for use in
computers with WLAN and webcam (1366×768 resolution), red

616600-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the palm rest (see Palm rest on page 73).

7.

Remove the keyboard (see Keyboard on page 78).

8.

Remove the top cover (see Top cover on page 82).

Remove the display on 39.6-cm (15.6-in) computers:
1.

Orient the computer in its normal position, face up with the display open as far as it will
comfortably go.
CAUTION: Support the display assembly when removing the retaining screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.

2.
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Disconnect the display cable (1) and the microphone cable (2) from the system board.
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3.

Release the WLAN cables from the cable run (3), being careful when pulling them through the
opening near the hard drive.

4.

Remove eight Torx M2.5×6.0 screws (1) that secure the display to the base enclosure. Be careful
of the grounding cable (2) that is secured by one of the hinge retaining screws.

5.

Lift the display assembly (3) from the base enclosure.

Remove the display on 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers:
1.

Orient the computer in its normal position, face up with the display open as far as it will
comfortably go.
CAUTION: Support the display assembly when removing the retaining screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.

2.

Disconnect the display cable (1) and the microphone cable (2) from the system board.
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3.

Release the WLAN cables from the cable run (3), being careful when pulling them through the
opening near the hard drive.

4.

Remove four Torx M2.5×6.0 screws (1) that secure the display to the base enclosure. Be careful
of the grounding cable (2) that is secured by one of the hinge retaining screws.

5.

Lift the display assembly (3) from the base enclosure.
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Remove the display assembly:
1.

If it is necessary to replace the display bezel, display enclosure, or display hinges, remove the two
mylar screw covers (1) and the 2 Phillips PM2.5×4.0 screws (2) that secure the display bezel to
the display assembly. The screw covers are available in the Rubber Kit, spare part number
598678-001.

2.

Starting at the top of the display, flex the bezel (1) and work around the periphery of the bezel
(2) and (3) to release the bezel from the display enclosure .

3.

Lift the bezel (4) from the display enclosure.
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4.

If it is necessary to replace the webcam module, disconnect the webcam cable from the module
(1), and pull the webcam module (2) that is attached with adhesive off the display enclosure. The
webcam module can be ordered by using spare part number 611026-001.

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.
5.

If it is necessary to replace the display hinges, remove the six Torx M2.5×6.0 screws (1) that
secure the display panel to the display enclosure.

6.

Lift the display panel up and out the housing (2).

Remove the display hinges from a 39.6-cm (15.6-in) computer:
1.
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Remove the eight Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display
panel.
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2.

Remove the display hinges (2) by pulling them away from the display panel. The left and right
display hinges are available in the Hinge Kit, spare part number 605769-001.

Remove the display hinges from 35.6-cm (14.0-in) or 33.8-cm (13.3-in) computers:
1.

Remove the six Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display panel

2.

Remove the display hinges (2) by pulling them away from the display panel. The left and right
display hinges are available in the Hinge Kit, spare part number 605769-001..

Remove the microphone:
1.

Pull the microphone from its socket (1) on the display enclosure.
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2.

Remove the microphone cable from the raceway (2) in the display enclosure.

To replace the display cable assembly:
1.

Place the display panel face down on a protected soft surface and remove the clear protector (1)
that covers the cable connector on the back of the panel.

2.

Remove the display cable (2) from the back of the display panel.

To remove the WLAN antennas:
1.
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Route the antenna cables (1) out of the routing channels in the inside of the display enclosure.
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2.

Peel the WLAN antenna receivers (2) from the enclosure

Reverse this procedure to assemble the display assembly.
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System board
NOTE: The system board spare part kit includes replacement thermal material.
Description

Spare part number

System board with UMA graphics and RTC battery with GL40 chipset having 667-MHz FSB

605748-001

System board, Park XT, with discrete graphics and RTC battery with PM45 chipset having 1066MHz FSB (for use in APJ only)

625491-001

System board with UMA graphics and RTC battery with GM45 chipset having 1066-MHz FSB

605747-001

System board with discrete graphics and RTC battery with PM45 chipset having 1066-MHz FSB

605746-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the hard drive (see Hard drive on page 59).

7.

Remove the optical drive (see Optical drive on page 68).

8.

Remove the fan (see Fan on page 69).

9.

Remove the palm rest (see Palm rest on page 73).

10. Remove the keyboard (see Keyboard on page 78).
11. Remove the top cover (see Top cover on page 82).
When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
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●

Memory module (see Memory module on page 64)

●

WLAN module (see WLAN module on page 66)

●

Modem module (see Modem module on page 109)

●

Heat sink (see Heat sink on page 70)

●

Processor (see Processor on page 71)

●

Audio board (see Audio board on page 111)
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Remove the system board on a 39.6-cm (15.6-in) computer:
1.

Position the computer with the front toward you.

2.

Release the audio ZIF connector (1) and disconnect the cable (2) from the left edge of the system
board.

3.

Remove the two Phillips M2.0×3.0 screws (3) that secure the system board to the base enclosure.

4.

Remove the optical drive extender by first removing the Phillips PM2.0×3.0 screw (1) that secures
the extender to the base enclosure.

5.

Lift the system board slightly and then pull the extender straight out (2) from the system board.

6.

Remove the hard drive extender by first removing the Phillips PM2.0×3.0 screw (1) that secures
the extender to the base enclosure.
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7.

Pull the extender out (2) of the system board and lift it from the base enclosure.

8.

Release the RJ-11 cable from the cable routing area, lift the connector from the base enclosure (1),
and disconnect the cable (2) from the system board.

9.

Disconnect the main battery cable (3) from the bottom of the system board.

10. Lift the system board at an angle (4) and slide it (5) out of the base enclosure.

Remove the system board on 35.6-cm (14.0-in) or 33.8-cm (13.3-in) computers:
1.
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Position the computer with the front toward you.
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2.

Remove the Phillips PM2.0×3.0 screw (1) that secures the board to the base enclosure, disconnect
the audio ZIF connector and remove the flat-ribbon cable (2) from the system board.

3.

Remove the optical drive extender on the 35.6-cm (14.0-in) computer by first removing the
Phillips PM2.0×3.0 screw (1) that secures the extender to the base enclosure.
NOTE: 33.8-cm (13.3-in) computers do not use an optical drive extender.

4.

Lift the system board slightly and then pull the extender straight out (2) from the system board.

5.

Release the RJ-11 cable from the cable routing area, lift the connector from the base enclosure (1),
and disconnect the connector (2) from the system board.

6.

Lift the system board at an angle (3) and disconnect the main battery cable (4) from the bottom of
the board.
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7.

Slide the system board (5) out of the base enclosure.

Reverse this procedure to install the system board.

Main battery connector
The main battery cable is included in Cable Kit 605795-001.
Before removing the main battery cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the hard drive (see Hard drive on page 59).

7.

Remove the optical drive (see Optical drive on page 68).

8.

Remove the fan (see Fan on page 69).

9.

Remove the palm rest (see Palm rest on page 73).

10. Remove the keyboard (see Keyboard on page 78).
11. Remove the top cover (see Top cover on page 82).
12. Remove the system board (seeSystem board on page 102).
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Remove the main battery cable:
1.

Remove the two Phillips PM2.5×4.0 screws (1) that secure the connector to the base enclosure.

2.

Lift the connector up (2) and out of the base enclosure.

Reverse the procedure to install the main battery connector.
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RTC battery
The spare part number for the RTC battery is 449137-001.
Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the hard drive (see Hard drive on page 59).

7.

Remove the optical drive (see Optical drive on page 68).

8.

Remove the fan (see Fan on page 69).

9.

Remove the palm rest (see Palm rest on page 73).

10. Remove the keyboard (see Keyboard on page 78).
11. Remove the top cover (see Top cover on page 82).
12. Remove the system board (seeSystem board on page 102).
Remove the RTC battery:
1.
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Position the computer right-side up with the front toward you.
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2.

Release the RTC battery from the socket (1) on the system board and lift the battery (2) up.

Reverse this procedure to install the RTC battery.

Modem module
Description

Spare part number

For use in all countries and regions except Australia and New Zealand

510100-001

For use only in Australia and New Zealand

510100-011

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the hard drive (see Hard drive on page 59).

7.

Remove the optical drive (see Optical drive on page 68).

8.

Remove the fan (see Fan on page 69).

9.

Remove the palm rest (see Palm rest on page 73).
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10. Remove the keyboard (see Keyboard on page 78).
11. Remove the top cover (see Top cover on page 82).
12. Remove the system board (seeSystem board on page 102).
Remove the modem module:
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1.

Position the computer right-side up with the front toward you.

2.

Remove the two Phillips PM2.5×3.0 screws (1) that secure the modem module to the system
board.

3.

Lift the modem module (2) straight up from the system board.

4.

With the modem raised, disconnect the RJ-11 cable (1) from beneath the modem.

5.

Remove the tape (2) that secures the cable to the system board and then, remove the cable (3).
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Reverse this procedure to install the modem module.

Audio board
NOTE: The spare part number for the audio board is 598684-001.
Before removing the audio board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 56).

5.

Remove the service door (see Service door on page 56).

6.

Remove the hard drive (see Hard drive on page 59).

7.

Remove the optical drive (see Optical drive on page 68).

8.

Remove the fan (see Fan on page 69).

9.

Remove the palm rest (see Palm rest on page 73).

10. Remove the keyboard (see Keyboard on page 78).
11. Remove the top cover (see Top cover on page 82).
12. Remove the system board (seeSystem board on page 102).
Remove the audio board from 39.6-cm (15.6-in) computers:
1.

Position the computer right-side up with the front toward you.
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2.

Remove the Phillips PM2.0×3.0 screw (1) that secures the audio board to the base enclosure and
then remove the audio board (2).

Remove the audio board from 35.6-cm (14.0-in) and 33.8-cm (13.3-in) computers:
1.

Release the latch (1) that secures the board to the base enclosure.

2.

Lift the audio board (2) from the base enclosure.

Reverse this procedure to install the audio board.
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5

Computer Setup

Computer Setup in Windows
Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter BIOS Setup.

3.

Select the File, Security, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

File menu
Select

To do this

System Information

●

View identification information for the computer and the
batteries in the system.

●

View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostics

Displays the following information:
●

System information
◦

Identification information for the computer and the
batteries in the system.

◦

Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

●

Start-up Test—Verifies the system components needed for
starting the computer.

●

Run-in Test—Runs a comprehensive check on system
memory.

●

Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

●

Memory Test—Runs a comprehensive test on any
memory installed in the computer.

●

Battery Test—Runs a comprehensive test on any batteries
installed in the computer.

●

Error Log—Displays a log file if any errors have
occurred.

Restore defaults

Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default

Restore the BIOS security settings to the factory default.
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Select

To do this

Ignore Changes and Exit

Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.
Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management > Create a New BIOS User Account
(requires a BIOS administrator password)

●

Select from a list of BIOS users.

●

Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft > AT-p (select models only)

Enable/disable Anti-theft Protection.

DriveLock Passwords

●

Enable/disable DriveLock on any computer hard drive
(enabled by default).

●

Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
Automatic DriveLock

Enable/disable Automatic DriveLock support (disabled by
default).

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.
CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.
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Select

To do this

Language

Change the Computer Setup language.

Boot Options

●

Set a Startup Menu delay (in seconds).

●

Set the MultiBoot Express Boot Popup delay in seconds.

●

Enable/disable custom logo (disabled by default).

●

Enable/disable display diagnostic URL (enabled by
default).

●

Enable/disable CD-ROM boot (enabled by default).

●

Enable/disable SD Card boot (enabled by default).

●

Enable/disable floppy boot (enabled by default).

●

Enable/disable PXE Internal NIC boot (enabled by
default).

●

Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

●

Set the legacy boot order.
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Select

To do this

Device Configurations

●

Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:
◦

Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦

Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

●

Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

●

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

●

Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security (enabled by default).

●

Select a SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:
◦

AHCI (Advanced Host Controller Interface)

◦

IDE (Integrated Drive Electronics)

◦

RAID (Redundant Array of Independent Disks) (select
models only)

Computer Setup in Windows

119

Select

To do this
NOTE: Availability of these options above varies by
computer model.
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●

Enable/disable secondary battery fast charge (enabled
by default).

●

Enable/disable HP QuickLook 2 (enabled by default).

●

Enable/disable preboot authentication on HP QuickLock
boot (enabled by default).

●

Enable/disable HP QuickWeb (enabled by default).

●

Enable/disable HP QuickWeb write protect (disabled by
default).

●

Enable/disable virtualization technology (select models
only; disabled by default).

●

Enable/disable Intel TXT (Trust Execution Technology)
(select models only; disabled by default).

●

Enable/disable Multi Core CPU (enabled by default).

●

Enable/disable Intel HT technology (enabled by default).

●

Enable/disable wake on USB (enabled by default).

●

Enable/disable Num lock state at boot (disabled by
default).

Select

To do this

Built-In Device Options

●

Enable/disable the wireless button state (enabled by
default).

●

Enable/disable embedded WWAN device (select
models only; enabled by default).

●

Enable/disable embedded WLAN device (enabled by
default).

●

Enable/disable embedded Bluetooth® device radio
(enabled by default).

●

Enable/disable the network interface controller (LAN)
(enabled by default).

●

Enable/disable LAN/WLAN device (disabled by
default).

●

Set the wake on LAN state. Options include the
following:
◦

Disabled

◦

Boot to Network (set by default)

◦

Follow Boot Order

●

Enable/disable the ambient light sensor (enabled by
default).

●

Enable/disable the notebook upgrade bay device
(enabled by default).

●

Enable/disable the fingerprint device (enabled by
default).

●

Enable/disable the integrated camera (enabled by
default).

●

Enable/disable the power monitor circuit (enabled by
default).

●

Enable/disable the audio device (enabled by default).

●

Enable/disable a modem device (enabled by default).

●

Enable/disable the microphone (enabled by default).

●

Enable/disable the internal speakers (enabled by
default).
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Select

To do this

Port Options

NOTE:

All port options are enabled by default.

●

Enable/disable the serial port (select models only).

●

Enable/disable the parallel port (select models only).

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.
CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

AMT Options (select models only)
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●

Enable/disable the 1394 port (select models only).

●

Enable/disable the ExpressCard slot (select models only).

●

Enable/disable the eSATA port (select models only).

NOTE:

All AMT options are disabled by default.

●

Enable/disable firmware verbosity.

●

Enable/disable AMT setup prompt (Ctrl-P)

●

Enable/disable USB key provisioning support.

●

Enable/disable unconfigure AMT on next boot.

●

Select terminal emulation mode. Options include the
following:
◦

ANSI (default setting)

◦

VT100

●

Enable/disable firmware progress event support.

●

Enable/disable initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults

Restore the default security settings.
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Computer Setup in Linux
Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.
NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.
NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer.

2.

Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.
Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:
●

To choose a menu or a menu item, use the arrow keys.

●

To select an item, press enter.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc.

●

To view navigation information, press f1.

●

To change the language, press f2.

2.

Select the File, Security, System Configuration menu.

3.

To exit Computer Setup, choose one of the following methods:
●

To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes And Exit. Then follow the instructions on the screen.

●

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2.

Use the arrow keys to select File > Restore Defaults, and then press enter.

3.

When the confirmation dialog box opens, press f10.

4.

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this section may not be supported by your
computer or your operating system.

File menu
NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.
Select

To do this

System information

●

View identification information for the computer.

●

View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults

Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit

Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes And Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.
Select

To do this

Setup Password

Enter, change, or delete a setup password.

Password Options

●

Enable/disable stringent security.

●

Enable/disable the password requirement on computer
restart.

●

Enable/disable DriveLock on any computer hard drive.

●

Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

DriveLock Passwords

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:
●

Fast: Runs the Disk Sanitizer erase cycle once.

●

Optimum: Runs the Disk Sanitizer erase cycle 3 times.

●

Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu
NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.
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Select

To do this

HDD Self-Test Options

Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.
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System Configuration menu
NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.
Select

To do this

Language

Change the Computer Setup language.

Boot options

●

Set an f9, f10, and f12 delay when starting up.

●

Enable/disable CD-ROM boot.

●

Enable/disable floppy boot.

●

Enable/disable internal network adapter boot.

●

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

●

Set the Express Boot Popup delay in seconds.

●

Set the boot order.

Device Configurations

◦

1st boot device: USB CD-ROM

◦

2nd boot device: USB floppy

◦

3rd boot device: USB SuperDisk

◦

4th boot device: Notebook hard drive

◦

5th boot device: USB hard disk

◦

6th boot device: Network controller

●

Swap the functions of the fn key and left ctrl key.

●

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:
◦

Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

◦

Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

●

Enable/disable BIOS DMA data transfers.

●

Enable/disable fan always on while connected to an AC
outlet.

●

Enable/disable data execution prevention.

●

Enable/disable LAN power saving mode.

●

Enable/disable SATA Native Mode.

●

Enable/disable Dual Core CPU.

●

Enable/disable HDD translation mode.

Computer Setup in Linux
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Select

To do this

Built-in device options

●

Enable/disable embedded WLAN Device Radio.

●

Enable/disable embedded Bluetooth Device Radio.

●

Enable/disable Network Interface Controller (NIC)

●

Enable/disable LAN/WLAN Switching.

●

Enable/disable Wake on LAN.

●

Enable/disable the integrated camera (webcam)

●

Enable/disable USB port.

●

Enable/disable ExpressCard slot.

Port options
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Specifications

Computer specifications
Metric

U.S.

Depth

24.96 cm

9.83 in

Width

37.18 cm

14.6 in

Height (front to rear)

2.75 to 3.55 cm

1.09 to 1.40 in

Depth

22.8 cm

8.98 in

Width

32.3 cm

12.67 in

Height (front to rear)

2.68 to 3.48 cm

1.06 to 1.38 in

Depth

22.8 cm

8.98 in

Width

32.3 cm

12.67 in

Height (front to rear)

2.68 to 3.48 cm

1.06 to 1.38 in

Weight – 39.6-cm (15.6-in) (equipped with optical drive,
WXGA display assembly, 1 memory module, hard drive, and
9-cell battery)

< 2.59 kg

< 5.70 lbs

Weight – 35.6-cm (14.0-in) (equipped with optical drive,
WXGA display assembly, 1 memory module, hard drive, and
6-cell battery)

< 2.26 kg

< 5.00 lbs

Weight – 33.8-cm (13.3-in) (equipped with optical drive,
WXGA display assembly, 1 memory module, hard drive, and
6-cell battery)

2.04 kg

4.5 lbs

Dimensions – 39.6-cm (15.6-in)

Dimensions – 35.6-cm (14.0-in)

Dimensions – 33.8-cm (13.3-in)

Input power
Operating voltage

18.5 V dc @ 4.74 A – 90 W

Operating current

4.74 A

Temperature

Computer specifications
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Metric

U.S.

Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

39.6-cm (15.6-in) display specifications
Metric

U.S.

Height

19.35 cm

7.6 in

Width

34.42 cm

13.5 in

Diagonal

39.49 cm

15.6 in

Number of colors

262,000

Contrast ratio

500:1 (typical BrightView), 400:1 (typical AntiGlare)

Brightness

200 nits (typical)

Dimensions

Pixel resolution
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Format

1366 × 768

Configuration

RGB
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Metric
Backlight

LED

Response Time

16 ms

Total power consumption

5.6 W (max)

Viewing angle @CR>10

5 VA

U.S.

39.6-cm (15.6-in) display specifications
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35.6-cm (14.0-in) display specifications
Metric

U.S.

Height

17.40 cm

6.9 in

Width

30.94 cm

12.2 in

Diagonal

35.50 cm

14.0 in

Number of colors

262,000

Contrast ratio

500:1 (min BrightView), 400:1 (min AntiGlare))

Brightness

200 nits (typical)

Dimensions

Pixel resolution
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Format

1366 × 768

Configuration

RGB

Backlight

LED

Response Time

8 ms (typ)

Total power consumption

3.8 W (max)

Viewing angle @ CR>10

SVA
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33.8-cm (13.3-in) display specifications
Metric

U.S.

Height

16.50 cm

6.5 in

Width

29.34 cm

11.5 in

Diagonal

33.66 cm

13.3 in

Number of colors

262,000

Contrast ratio

500:1 (min BrightView), 400:1 (min AntiGlare))

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Format

1366 × 768

Configuration

RGB

Backlight

LED

Response Time

8 ms (typ)

Total power consumption

4.5 W (max)

Viewing angle @ CR>10

SVA

33.8-cm (13.3-in) display specifications
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Hard drive specifications
500-GB*

320-GB*

250-GB*

160-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

Single track

3 ms

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

24 ms

Logical blocks

1,048,576,000

625,141,400

488,376,280

312,560,640

Disc rotational speed

7200 and 5400
rpm

7200 and 5400
rpm

7200 and 5400
rpm

7200 and 5400
rpm

Operating temperature

5°C to 55°C
(41°F to 131°F)

5°C to 55°C
(41°F to 131°F)

5°C to 55°C
(41°F to 131°F)

5°C to 55°C
(41°F to 131°F)

Dimensions

Seek times (typical read, including setting)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE:
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Certain restrictions and exclusions apply. Contact technical support for details.
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DVD-ROM Drive specifications
Applicable disc

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R,
CD-RW, Photo CD (single and multisession), CD-Bridge

Access time

CD

DVD

Random

< 100 ms

< 125 ms

Cache buffer

512 KB

Data transfer rate
CD-R (24X)

3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X)

1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2

16.6 MB/s

DVD-ROM Drive specifications
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DVD±RW Double-Layer Combo Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM,
CD-ROM XA, MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW),
CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Cache buffer

2 MB

Data transfer rate
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24X CD-ROM

3,600 KB/sec

8X DVD-ROM

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode
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DVD+R, DVD+RW, DVD-R, DVDRW, DVD-RAM
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Backup and recovery

Backup and recovery in Windows 7
Overview
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.
Backup and Restore provides the following options:
●

Creating a system repair disc (select models only)

●

Backing up individual files and folders

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

Backup and recovery in Windows 7
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You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore , follow these steps:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use the Backup and Restore to recover information you have
previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Click Start > All Programs > Maintenance > Backup and Restore .

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.
To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs usin g the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

Backup and recovery in Windows 7
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NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: Select Start, right-click
Computer, click Manage, then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 to enter HP Recovery.

5.

Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only) , you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD, go
to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD, follow these steps:
NOTE: This process takes several minutes.
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1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.
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3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

Backup and recovery in Windows Vista
Overview
To protect your information, use Backup and Restore to back up individual files and folders, back up
your entire hard drive (select models only), or create system restore points. In case of system failure,
you can use the backup files to restore the contents of your computer.
Backup and Restore provides the following options:
●

Backing up individual files and folders

●

Backing up the entire hard drive (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

Backup and recovery in Windows Vista
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●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore , follow these steps:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to back up your entire computer (select models only) or your files.
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
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●

Windows recovery tools: You can use Backup and Restore to recover information you have
previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.
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NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Click Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.
NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the
“Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3.

Restart the computer, and then press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition. To find the partition, select Start
> Computer.
NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4.

Press f11 to enter HP Recovery.

5.

Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased
separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow
the on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows Vista operating system DVD, follow these steps:
NOTE: This process takes several minutes.
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1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview
To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.
Windows provides the following options:
●

Backing up individual files and folders

●

Backing up all files and folders

●

Scheduling automatic backups

●

Creating recovery points

●

Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:
●

Store personal files in the My Documents folder, and back it up periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen you want to save.

b.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, click Edit > Paste.

Backup and recovery in Windows XP
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The screen image is added to the document.
d.

Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Click Start > All Programs > Accessories > System Tools > Backup.

2.

Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

●

Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1.

If possible, back up all personal files.

2.

Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

3.

Click Restore files and settings, and then click Next.

4.

Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this
topic in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.
To recover your operating system and programs, follow these steps:
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1.

If possible, back up all personal files.

2.

Insert the Operating System disc into the optical drive.
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3.

Shut down the computer.

4.

Turn on the computer.

5.

Follow the on-screen instructions to install the operating system.

6.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7.

Follow the on-screen instructions to install the drivers and programs.

Backup and recovery in Windows XP
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Connector pin assignments

Audio-in (microphone)

Pin

Signal

1

Audio signal in

2

Audio signal in

3

Ground

Audio-out (headphone)
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Pin

Signal

1

Audio out, left channel

2

Audio out, right channel

3

Ground
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External monitor

Pin

Signal

1

Red analog

2

Green analog

3

Blue analog

4

Not connected

5

Ground

6

Ground analog

7

Ground analog

8

Ground analog

9

+5 VDC

10

Ground

11

Monitor detect

12

DDC 2B data

13

Horizontal sync

14

Vertical sync

15

DDC 2B clock

External monitor
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HDMI

150

Pin

Signal

1

Transition minimized differential signal (TMDS) data 2+

2

TMDS data 2 shield

3

TMDS data 2–

4

TMDS data 1+

5

TMDS data 1 shield

6

TMDS data 1–

7

TMDS data 0+

8

TMDS data 0 shield

9

TMDS data 0–

10

TMDS clock+

11

TMDS clock shield

12

TMDS clock-

13

Consumer electronic control (CEC)

14

Not connected

15

DDC clock

16

DDC data

17

Ground

18

+5V power

19

Hot plug detect
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RJ-11 (modem)

Pin

Signal

1

Unused

2

Tip

3

Ring

4

Unused

5

Unused

6

Unused

RJ-11 (modem)
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RJ-45 (network)

Pin

Signal

1

Transmit +

2

Transmit -

3

Receive +

4

Unused

5

Unused

6

Receive -

7

Unused

8

Unused

Universal Serial Bus

152

Pin

Signal

1

+5 VDC

2

Data -

3

Data +

4

Ground
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Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for all countries and regions
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Requirements for specific countries and regions
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Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.

Battery
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Perform the following steps to disassemble the display assembly:
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1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside-down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

Display
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
17. Remove the backlight frame from the display panel.

Display
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter
spare part numbers 39
AC adapter, identifying 23
access door
spare part number 32
AMT options 122
AMT setup prompt (Ctrl-P) 122
firmware progress event
support. 122
firmware verbosity 122
initiate Intel CIRA 122
termiinal emulation mode 122
unconfigure AMT on next
boot 122
USB key provisioning support
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antenna, disconnecting 67
audio board
removal 111
spare part number 30, 111
audio, product description 4
audio-in (microphone) jack
identifying 16
pin assignments 148
audio-out (headphone) jack
identifying 16
pin assignments 148
B
backing up
Windows 7 137
Windows Vista 141
Windows XP 145
Backup and Restore 137, 138,
141, 142
base enclosure
spare part number 30

battery
removal 56
spare part number 30, 56
battery bay 19
battery release latches,
identifying 19
battery, identifying 23
bays, battery 19
BIOS administrator password 117
Bluetooth module
removal 89
spare part number 29, 89
Bluetooth module cable,
illustrated 36
boot options 118, 127
boot order 118, 127
built-in device
ambient light sensor 121
audio device 121
bay device 121
Bluetooth device 121
fingerprint reader 121
integrated camera 121
internal speakers 121
microphone 121
modem 121
Network Interface Controller
(LAN) 121
options 121
power monitor circuit 121
Wake on LAN 121
wireless button 121
WLAN device 121
WWAN device 121
buttons
power 13

C
Cable Kit
contents 36
spare part number 36
cables, service considerations 50
caps lock light, identifying 11
chipset, product description 2
components
additional hardware 23
bottom 19
display 20
front 16
left-side 18
right-side 16
top 10
wireless antennas 22
computer feet
locations 55
spare part number 55
Computer Setup
accessing 113, 123
Diagnostics menu 126
File menu 115, 125
navigating and selecting 113,
124
restoring factory settings 114,
124
Security menu 117, 126
System Configuration menu
118, 127
using 113, 124
computer specifications 129
connectors, service
considerations 50
cord, power 23
D
DC-in cable, illustrated 36
device configurations 119
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Diagnostics menu 126
discs
Driver Recovery 146
Operating System 146
Disk Sanitizer 117
diskette drive
precautions 50
product description 4
display assembly
removal 93
spare part numbers 27, 93
display bezel
removal 97
spare part number 33
display component recycling 155
display enclosure
spare part number 34
Display Hinge Kit
spare part number 33
Display Hinge Kit, spare part
number 99
display panel
removal 99
display specifications 130, 132,
133
drive button
optical drive 17
DriveLock
automatic 117
password 117
Driver Recovery disc 146
drives
boot order 118, 127
optical 16
preventing damage 50
DVD-ROM Drive
removal 68
spare part number 32, 38, 68
specifications 135
DVD±RW Double-Layer Drive with
LightScribe
precautions 50
removal 68
spare part number 32, 38, 68
specifications 136
E
electrostatic discharge 51
esc key, identifying 14, 15
Ethernet, product description 4
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Execution disable 119
ExpressCard slot bezel,
illustrated 35
ExpressCard slot, identifying 18
external media cards, product
description 5
external monitor port
identifying 18
pin assignments 149

internal display switch,
identifying 13

F
f11 recovery 140, 143
fan
removal 69
spare part number 28, 69
feet
locations 55
spare part number 55
File menu 115, 125
fn key, identifying 14, 15
function keys, identifying 14, 15

K
keyboard
product description 6
removal 78
spare part number 28, 78
keypad keys, identifying 14, 15
keys
esc 14, 15
fn 14, 15
function 14, 15
keypad 14, 15
wireless 14, 15

G
graphics, product description 2
grounding equipment and
methods 53
H
hard drive
precautions 50
product description 3
removal 59
spare part numbers 31, 37,
59
specifications 134
hard drive bracket, removal 61
hard drive extender
spare part number 29
hard drive recovery 140, 143
HDMI port, pin assignments 150
headphone (audio-out) jack 16
pin assignments 148
heat sink
removal 70
spare part number 28
hinge, spare part number 99
HP QuickLook 120
I
integrated microphone,
identifying 21

J
jacks
audio-in (microphone) 16
audio-out (headphone) 16
RJ-11 (modem) 16
RJ-45 (network) 18

L
language, changing in Computer
Setup 118
latches, battery release 19
LCD Cable
contents 37
spare part number 37
legacy support, USB 113, 119,
123, 127
lights
caps lock 11
optical drive 17
power 12
webcam 21
wireless 12
M
main battery cable
removal 106
mass storage devices, spare part
numbers 37
memory module
product description 3
removal 64
spare part numbers 30, 64
microphone (audio-in) jack
identifying 16
pin assignments 148

microphone cable
spare part number 34
model name 1
modem jack, pin assignments
151
modem module
product description 4
removal 109
spare part numbers 29, 109
monitor port
external 18
pin assignments 149
Multi Core CPU 120
N
network jack, pin assignments
152
Num lock state 120
O
Operating System disc 146
operating system, product
description 6
optical drive
identifying 16
precautions 50
product description 4
removal 68
spare part number 32, 38, 68
specifications 135, 136
optical drive bezel, illustrated 35
optical drive button, identifying
17
optical drive extender
spare part number 29
optical drive light, identifying 17
P
packing guidelines 52
palm rest
removal 73
spare part number 28
spare part numbers 73
panels, product description 2
passwords 117, 126
pin assignments
audio-in jack 148
audio-out (headphone) jack
148
external monitor port 149
HDMI 150

headphone (audio-out) jack
148
microphone (audio-in) jack
148
modem jack 151
monitor port 149
network jack 152
RJ-11 151
RJ-45 (network) jack 152
Universal Serial Bus (USB)
port 152
plastic parts 49
Plastics Kit
contents 35
spare part number 35
pointing devices, product
description 6
port options 122
1394 port 122
eSATA port 122
ExpressCard slot 122
flash media reader 122
parallel port 122
serial port 122
USB port 122
ports
external monitor 18
HDMI 18
product description 5
USB 16, 18
power button, identifying 13
power cord
set requirements 153
spare part numbers 39, 40
power cord, identifying 23
power light, identifying 12
power requirements, product
description 6
power switch board
removal 87
spare part number 28
processor
product description 1
removal 71
spare part numbers 29, 71
product description
audio 4
chipset 2
diskette drive 4
Ethernet 4

external media cards 5
graphics 2
hard drives 3
keyboard 6
memory module 3
modem module 4
operating system 6
optical drives 4
panels 2
pointing devices 6
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 9
wireless 5
product name 1
R
recovery partition 140, 143
release latches, battery 19
removal/replacement
preliminaries 49
procedures 54
restore factory settings 115
restore security defaults 115, 122
restoring the hard drive 140, 143
RJ-11 (modem) jack
identifying 16
pin assignments 151
RJ-45 (network) jack
identifying 18
pin assignments 152
RTC battery
removal 108
spare part number 29, 40,
108
Rubber Kit, spare part number 39
S
SATA (Serial Advanced Technology
Attachment) devices
AHCI (Advanced Host Controller
Interface) 119
IDE (Integrated Drive
Electronics) 119
SATA (Serial Advanced Technology
Attachment) devices) 119
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Screw Kit
spare part number 39
SD Card Reader
identifying 16
security cable slot, identifying 18
Security menu 117, 126
anti-theft Protection 117
Automatic DriveLock 117
change password 117
Disk Sanitizer 117
DriveLock 117
f fingerprint reader reset 117
HP SpareKey 117
HP SpareKey enrollment 117
password policy 117
set up BIOS administrator
password 117
System IDs 117
user management 117
security, product description 6
service considerations 49
service door
removal 56
spare part numbers 56
service tag, location 24, 54
serviceability, product description
9
set security level 122
setup utility
Diagnostics menu 126
File menu 115, 125
navigating and selecting 113,
124
restoring factory settings 114,
124
Security menu 117, 126
System Configuration menu
118, 127
slots
ExpressCard 18
security cable 18
speaker
identifying 13
speakers
removal 92
spare part number 30, 92
specifications
computer 129
display 130, 132, 133
DVD-ROM Drive 135
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DVD±RW Double-Layer Drive
with LightScribe 136
hard drive 134
optical drive 135, 136
static-shielding materials 53
stringent security 126
system board
removal 102
spare part numbers 28, 102
system board assembly, spare part
number 28
System Configuration menu 118,
127
system date and time 115
system diagnostics 115
system fan 119, 127
system IDs 117
system information 115, 125
T
tools required 49
top cover
removal 82
spare part number
TouchPad board
spare part number
TouchPad button 10
TouchPad scroll zone
TouchPad, identifying
transporting guidelines

28, 82
28
10
10
52

U
Unified Extensible Firmware
Interface (UEFI) mode 120
USB board
spare part numbers 29
USB connector assembly
removal 90
spare part number 90
USB legacy support 113, 119,
123, 127
USB port
identifying 16, 18
pin assignments 152
V
vents, identifying 18
Virtualization Technology
W
wake on USB 120

120

webcam light, identifying 21
webcam module
spare part number 34
webcam, identifying 21
Windows 7 operating system
DVD 140
Windows Backup utility 145,
146
Windows recovery 139, 142,
146
Windows Vista operating system
DVD 144
wireless antenna, disconnecting
67
wireless light, identifying 12
wireless, product description 5
WLAN antennas, identifying 22
WLAN module
removal 66
spare part numbers 30, 66
workstation guidelines 52
WWAN antennas, identifying 22

